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turn to the experts

What is Field Assistant?

Field Assistant is a standalone tool you can install on your computer or laptop to access a single Open controller,
several Open controllers, or a network of Open controllers and routers. You do not need to be connected to the
Internet. You can communicate with the Open devices using local access or over an IP network.

NOTE A Field Assistant system allows a maximum of 750 Open controllers. Field Assistant does not work with
CCN.

Field Assistant basics

In Field Assistant, you can use a Local Access connection. Or, you can use an IP connection to access an entire
network of routers and controllers.

After you have connected to a router or controller, you can:

e Upload parameters and source files (control programs, drivers, graphics, .touch files, and BACview® files)
from the controller to Field Assistant

e  Commission and start up equipment

e  Adjust setpoints and other control parameters
e  View current trends stored in the controller

e Set and change schedules in the controller

° Run preconfigured reports that display locked values, points list, network 1/0, alarm sources, equipment and
controller status, and test and balance configuration

e Use the Snap and ViewBuilder applications to edit or create new control programs and views
e Download programs, schedules, parameters, and BBMD tables to controllers

e  Export updated source files

To use Field Assistant, you must understand these terms:

Source Files Includes any or all of the following files:
e  Control programs (.equipment)
e  Graphics (.view)
o  BACview® files (.bacview)
e Screen files (.touch)
e  Drivers (.driver)

Parameters Editable properties within a control program or driver

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
Help All rights reserved
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What is Field Assistant?

Import Brings files into Field Assistant. Import source files (sourcefiles.zip) from the Field
Assistant Launcher.

NOTE Your manufacturer or representative must supply the source files.

Export Takes source files from your Field Assistant system to use in another system. Export
source files (sourcefiles.zip) from the Field Assistant Launcher.

Download Sends source files, schedules, or parameters from Field Assistant to the controller.

Upload Retrieves source files or parameters from the controller and stores them in Field
Assistant.

Field Assistant tools

Develop and configure graphics and a system database for your Field Assistant system using the following Field

Assistant tools.

1 Install the tools from your Tech Tools DVD to your computer. If the installation is not automatically started,
double-click the Windows folder > Disk 1 > InstData > Setup > setup.exe.

2  Complete the Installation Wizard.

Use...

EquipmentBulider

Virtual BACview®

BBMD Configuration Tool

MSTP Capture Utility

Test & Balance

Snap

AppLoader

Field Assistant v6.5

Help

To...

Build or edit control programs (.equipment files) and graphics for
programmable controllers

View and change property values and the controller's real time clock
Configure BACnet/IP Broadcast Management Devices (BBMDs)

NOTE If your system has multiple routers that reside on different IP
subnets, you must set up one router on each IP subnet as a BACnet/IP
Broadcast Management Device (BBMD).

Capture BACnet traffic on a variety of media types. It is intended for use
in situations where Carrier Control Systems Support needs a network
capture to troubleshoot communications.

e  Calibrate airflow in a VAV or VVT Zone controller

e Calibrate the static pressure in a VVT Bypass controller

e  Commission air terminals

e  Override reheat and terminal fans

NOTE Use Test & Balance to manipulate the controllers associated with
an air source, but not the air source itself, or heating and cooling
equipment such as chillers and boilers.

Build custom control programs using individual blocks of programming
code called microblocks

Use to download .clipping files to restore factory defaults and check
Module Status (Modstat) via the RNET port

Carrier Proprietary and Confidential CARRIER CORPORATION ©2016

All rights reserved
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What's new in the Field Assistant application v6.5

What's new in the Field Assistant application v6.5

Feature

New in v6.5:

Web browser support

Supported database type (page
6)

Optimize download (page 29)

New features for handling
parameter mismatches (page
34)

Security enhancements

Display gap in trend graph line
(page 68)

BACnet Firewall

BACnet Objects tab on
Properties page (page 43)

Field Assistant v6.5
Help

Improvement

The Field Assistant application:
e No longer supports IE8, IE9, or IE10.
e Now supports the Microsoft® Edge web browser.

Field Assistant uses an Apache Derby database and no longer supports an
Access® database type. If you have an Access database from a previous Field
Assistant version that you want to use in v6.5, you will have to convert the
database to Derby first.

You must use the upgrade tool on the Tech Tools v6.5 Installation DVD to
convert Access databases from previous Field Assistant version. See
Converting Access databases to Derby (page 6).

The default for Optimize download for Open PIC controllers is now off
(unchecked), which results in Full Source download, unless you check it to
enable optimizing.

Any parameter mismatch now appears on the Properties page with a purple
box around it and hover text to help determine what action needs to take
place. If a change was made in the controller, the Properties page now shows
the controller value.

The Field Assistant application determines where a change occurred, what
action needs to take place, and provides a new Resolve button that you can
click to have any mismatches automatically handled. Clicking the Details
button shows an additional Resolve column that indicates whether a
mismatch will be resolved through upload or download. This same Resolve
column has also been added to the Parameter Mismatch report.

On the Devices > Manage tab for the router, the driver now appears so that
you can choose to solve parameter mismatches in the driver, the control
program(s), or both.

e  Apache Tomcat web server has been upgraded to v7.0.61.
e The Field Assistant application has been upgraded to Java 8 update 51.

To show a gap in a trend graph line if trend data is missing, you can check
Display gap in graph line for missing data on an individual trend graph page.

The v6-02 drivers for Carrier controllers with Ethernet capability have a new
BACnet firewall feature that allows you to restrict communication with the
controller to all private IP addresses and/or to a whitelist of IP addresses that
you define. To set this up, right-click the controller in the navigation tree,
select Driver Properties and then BACnet Firewall. Follow the instructions in
the interface.

The BACnet Points tab has been renamed BACnet Objects and now includes
information specific to Display microblocks if they are included in the control
program.

Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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What's new in the Field Assistant application v6.5

Feature Improvement

Carrier® ChillerVu™ You can find and upload the Carrier® ChillerVu™ (OPN-PSM-MPCXPE) as an
Open device if it is on a BACnet over MS/TP or BACnet over ARC156 network.

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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Computer, operating system, and database requirements for Field Assistant

Computer, operating system, and database requirements for Field

Assistant

The computer should have at least:

¢ Dual core processor

* 2 GB RAM

* 30 Gigabyte Hard drive

e Communications link of 10 Mbps or higher

The Field Assistant application will work with slower computers and slower links, but the results may not be

satisfactory.

You must use a computer with a Windows® operating system and either Internet Explorer® v11 or Microsoft®
Edge browser. A Field Assistant v6.5 or later system is supported on any of the following operating systems (32-bit

and 64-bit).

e  Windows® 10 Professional

e  Windows® 8.1 Professional and Enterprise
e  Windows® 7 Professional and Ultimate

e  Windows® Vista Business or Ultimate SP2

Field Assistant v6.5 only uses an Apache Derby database. If you have an Access database from a previous Field
Assistant version that you want to use in v6.5, see Converting Access databases to Derby (page 6).

The memory requirements will vary based on the:

e number of pieces of equipment and device instances

e size of the control programs

For this With this number of...
size
system...
Instances of Physical Points Passmark
equipment and and Display Total
devices 1 Objects Score 2
Small 0-250 0-1000 2000
Medium 250 - 1000 1000 - 5000 3000
Large 1000 - 10,000 5000 - 50,000 5000
Huge more than more than 6500
10,000 50,000

1 Total number of control programs and controllers-+.
2 For more information, see www.CPUbenchmark.net.

3 If using 32-bit, you cannot use more than 1.2GB for the JVM.

Passmark

Single-
threaded
Score

800

1000
1400

1600

RAM
Minimum/

Recommend-

ed
4 /4GB

4/ 8GB
6/ 12GB

16/ 16GB 4

The computer should have at least a dual core processor and...

JVM Memory Operating

Minimum/ system

Recommend-

ed

1/1GB 32 or 64-bit
server 3

2 /4GB 64-bit server

4 / 8GB 64-bit server

12 / 12GB 64-bit server

4 For a huge system with minimal user activity, the average piece of equipment or instance device requires approximately 300KB
of server RAM. Contact Automated Logic® Technical Support for server sizing recommendations.
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Computer, operating system, and database requirements for Field Assistant

Converting Access databases to Derby

Field Assistant v6.5 creates sites using Derby databases. Older versions of Field Assistant created sites using
Access, which is not compatible with Field Assistant v6.5. In order to open older Field Assistant sites created with
Access, these sites must be converted to Derby by using the Field Assistant v6.0 database conversion file. This
update file is located on the Tech Tools v6.5 DVD.

& CAUTION This update can only be applied to Field Assistant v6.0. If you are upgrading from a pre-6.0
version, you must first install Field Assistant v6.0 and upgrade all of your Field Assistant systems to v6.0. Then you
must install Tech Tools v6.5 and use the following instructions to convert your databases through v6.0. You
cannot open a system in v6.5 until you have converted them.

1 Open the Field Assistant v6.0 Launcher screen.
NOTE Do NOT click the arrow to start a system.
2 From the Field Assistant v6.0 Launcher, click Help > Update to open the Apply Update dialog.

Help Topics
Permission Keys

About

3 Onthe Apply Update dialog, in the Update File field, browse to the Tech Tools v6.5 Installation DVD, open
FA60_DB_Migration_Update > WS60_Migrate_Access_To_Derby.update file and click Select.

4 Click the Apply and Restart Now or Update with Restart Later button.
From the Field Assistant v6.0 Launcher, click Help > Database Upgrade Utility.
NOTE This option appears only after applying the update file.
6 In Target Coversion Directory, browse to the i-Vu_Tools_6.5\webroot folder and click Select.

7  In Systems To Convert, browse to your i-Vu_Tools_6.0\webroot folder and click Select. You can use the Shift
or Ctrl key to multi-select databases.

& CAUTION You must get your database(s) from the webroot directory only. If, for instance, you have files
on a USB drive, you must first place them on your computer in the i-Vu_Tools_v6.0\webroot folder. No other
path is accepted.

8 Click the Start Conversion button.
NOTES

o  The top progress bar Overall conversion progress displays the progress of all of the databases you
selected. The total conversion is finished when the bar reaches the end.

o  The two lower bars show the conversion progress of each database.
9  When complete, click Exit.
10 Close the Field Assistant Launcher v6.0.

11 You can now start your systems in the Field Assistant Launcher v6.5. See Getting Started (page 7).

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
Help All rights reserved
6



Getting started

Getting started

1

If you will be using a database from a pre-v6.5 version of Field Assistant, you must first convert the Access
database to a Derby database. See Converting Access databases to Derby (page 6) for details.

Set up your computer and browser (page 7).

Do one of the following:
Connect to a controller's Local Access port (Open only) (page 8)
Connect to a controller over an IP network (Open or XT) (page 9)

Start Field Assistant. (page 10) If using local access, Field Assistant automatically finds and displays the
device you are connected to.

If you are discovering a network from a router, select the router in the navigation tree and click Devices >
Manage to find associated controllers. Then select All Content and click Upload.

If connecting to a controller, on the Properties page, click Upload. See Upload source files from a controller
(page 11).

Start up, commission, or change parameters, programs, or drivers as needed. See Working with equipment
(page 21).

Export source files from the Field Assistant Launcher (page 12) to use in the i-Vu® Standard, Plus, or Pro
application.

To set up a computer and web browser to view Field Assistant

Set the monitor's screen resolution to a minimum of 1024 x 768 with 24- or 32-bit color quality

You may want to disable the computer's navigation sounds.

NOTES

The instructions below are for Internet Explorer 11. Other versions may vary slightly. See your web browser's
Help if necessary.

If the menu bar is not visible, right-click on the window's header, and then select Menu bar.

Browser settings Where to change setting in IE11

Accept First-party and Tools > Internet Options > Privacy > Advanced button
Third-party cookies.*

Automatically check for newer Tools > Internet Options > General > Browsing history > Settings button
versions of stored pages*
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Getting started

Browser settings

Load ActiveX Control*

Select Play animations in web
pages

Disable all the options on the
Explorer Bar

Disable web browser's pop-up
blockers

Disable external toolbar pop-up
blockers

Hide the browser's toolbars

To...

Maximize the web browser
window

Where to change setting in IE11

Tools > Internet Options > Security > Custom Level button. Under ActiveX
controls and plug-ins, set the following:

e Download signed ActiveX controls > Prompt

e Download unsigned ActiveX controls > Disable

¢  Run ActiveX controls and plug-ins > Enable

Script ActiveX controls marked safe for scripting > Enable

Tools > Internet Options > Advanced > under Multimedia

View > Explorer Bars

Tools > Pop-up Blocker > Turn Off Pop-Up Blocker

Varies

View > Toolbars

Do the following...

Press F11 on your keyboard to turn full-screen mode on\off, or use the
minimize/maximize button in the top right corner of the browser window.

* Field Assistant cannot function without this setting.

To connect to a controller's Local Access port (Open controller only)

PREREQUISITE For Field Assistant to communicate with the controller, the controller must have been downloaded

with at least its driver (4.x or later).

& CAUTION If multiple controllers share power but polarity was not maintained when they were wired, the
difference between the controller's ground and the computer's AC power ground could damage the USB Link and
the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB
Link. Purchase a USB isolator online from a third-party manufacturer. Plug the isolator into your computer's USB
port, and then plug the USB Link cable into the isolator.

Using a USB Link

1 If your computer does not already have the USB Link driver installed, install it before you connect the USB

Link to your computer.

NOTE The driver is installed with Field Assistant. But if needed, you can get the latest driver from
http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx.
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Connect the computer to the local access port of the controller, ZS sensor, or an SPT sensor using the USB
Link cable(s).

Connect to Connect to
USB port Local Access port

B ————<(]) a:

7 3/4 in. 12 ft

T
USB Link

NOTE If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link
cable into the isolator.

To connect to a controller over an IP network (Open or XT controller)

Connect a CAT5 Ethernet cable to your computer and to:
o  The controller's Ethernet port
or
o A hub onthe same IP network as the controller
Set your computer's IP parameters so that it can communicate on the controller's IP network.
Open Field Assistant Launcher, and start your system. See Start Field Assistant (page 10).

On the Devices page > Advanced tab, set the Field Assistant BACnet/IP network number to match the
number of the controller's BACnet/IP network (supplied by your manufacturer or representative.).

On the Devices page > Manage tab, click Find Devices.

If you have multiple routers, select one at a time on the navigation tree. Click Find Devices to find the devices
under that router.

On the Devices page > Manage tab, select a controller in the list. Use Ctrl+click, Shift+click, or the Select All

checkbox to select multiple controllers. Click Upload All Content.

The message appears This will upload all content for the controller. Are you sure you want to do this? Click
OK.

NOTE If a message appears stating that a file is missing, you must stop and import the source files provided
by your manufacturer or representative. Follow these steps:

a) Close Field Assistant.

b) Click . on the Launcher to stop your system. The Launcher will disappear and then take a few seconds
to reappear.

c) Click Source Files . Select the sourcefiles.zip file.

d) Click } to start your system.
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Getting started

To start

ey Upload |

f)  Return to Step 1.
Start up, commission, or set parameters as needed.

NOTE You can make changes to one controller and then copy the changes to other controllers that have the
same control program. See Copying properties from one controller to another (page 54).

Field Assistant

From your desktop, select Start > All Programs > i-Vu_Tools_ x.x > Field Assistant.

Click + on the Field Assistant Launcher and type your System Name.

The System Name cannot:

Begin with a number.

Contain special characters other than a dash or an underscore.

Exceed 40 characters.

Contain capital letters or spaces. Use an underscore or dash between words.

Click Create.

If your manufacturer or representative provided source files, click Import , browse to sourcefiles.zip,
then click Open.

Select your System Time Zone. Your selection applies to your current system when you click ﬁ
Under Communications, select the method you are using to connect to a controller or system:
o IP network - select your IP. See To connect to a controller over an IP network (page 9).

o  Local Access - select your USB Comm port from the drop-down list.

NOTE If you are using a USB Link (#USB-L), you must connect it to your computer and the controller
before launching Field Assistant in order for your Comm port to appear in the drop-down list. If you do not
see your Comm port, close the Field Assistant Launcher, make the connection, then restart Field
Assistant.

Click ﬁ to start your system.

o If using local access, Field Assistant will find and display the controller you are connected to and any
other controllers on its local network.

o Ifuisng an IP network, you must click Find Devices, then select a router in the navigation tree and click
Find Devices again.

NOTE When you click . to stop your system, the Field Assistant Launcher disappears for a few seconds and

then

reappears.
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To import source files

You can import and export source files from the Field Assistant Launcher. If the controllers have full source in
them, you do not need to import the source files. You will upload them from the controllers.

1 If Field Assistant is running, close the Field Assistant window and click . on the Launcher to stop your
system. The Launcher will disappear and then take a few seconds to reappear.

2  Click Source Files . Select the sourcefiles.zip file.

3 Click ﬁ to start your system.

To upload source files from a controller

NOTE For best results, connect your computer to a controller on the same network segment as the controllers
that you want to upload.

1 Click the link (shown below) to the controller that your computer is connected to.

Connection
status Local Access: Connected Link to controller

£3) 30 BN Chiser that you are physically
connected to

(71 Acme Corp

2 On the Properties page, click Upload , and then click OK.

NOTE If a message appears stating that a file is missing, you must stop and import the source files provided
by your manufacturer or representative. Follow these steps:

a) Close Field Assistant.

b) Click . on the Launcher to stop your system. The Launcher will disappear and then take a few seconds
to reappear.

c) Click Source Files . Select the sourcefiles.zip file.

d) Click ﬁ to start your system.

e) Click i,

f)  Return to Step 1.

3 Start up, commission, or set parameters as needed. Perform the services required. See Working with
equipment (page 21).
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4 If you have more controllers, move your USB Link cable to the next controller or to a controller on another
network, then repeat steps 1-3.

NOTES

o  To upload more than one controller at the same time, select the system level on the navigation tree,
then go to the Devices page > Manage tab. Select the controller(s) you wish to upload in the list on the

page. Ctrl+click to multi-select, or enable Select all. Select Upload All Content, then click Upload .

o  After uploading, we recommend that you give each controller a unique name by selecting the system
level in the navigation tree to go to Devices page > Manage tab. Click in the Name field to edit.

To export source files

1 Close the Field Assistant window.

2 In the Field Assistant Launcher, click . to stop your system.

3 cliok _Expart |

4 Browse to a location where you want to save the source files.
NOTE Do not change the extension (sourcefiles.zip).
5 Click Save Files.
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Getting to know the Field Assistant interface

Connection status
Click to show/hide

navigation pane Help button
Category
Back button Action buttons Print button
! Item

Local Access: Connecled Graphics Properties Schedules
aa
ot - VAVE3 Zone Alarms
AV Commissioning
Equipment  » | Locked Values
Network 10
Paoint List

VAVHS Zone

Heating sChedul Occupied
Nol Active

Navigating the system

NOTE Use only the Field Assistant interface to navigate through Field Assistant; do not use the web browser’s
navigation buttons.

To navigate to an item in the system
1 Select an item on the navigation tree.

2 Use the action buttons and their drop-down menus to navigate to specific types of information about the
selected tree item.

3 Use the tabs to filter the information further.
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Getting to know the Field Assistant interface

To navigate using links

Click links to jump to related pages.

To show, hide, or resize the navigation tree

Local Access: Connected

Router 38

Click at the top of the navigation pane to hide or show the navigation tree.

Click and drag the tab on the right side of the tree to adjust its width.

Zooming in and out

e Tozoom in and out on the Field Assistant interface:
o  Hold down Ctrl and press + or -. Press Ctrl+0 to return to 100%.
o Hold down Ctrl while rolling your mouse wheel.

o  Use your web browser's zoom functions.

e |f a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane.
Select Scale to Fit again to return the graphic to its original size.

Using right-click menus

You can right-click the following items to select options:

A tree item The Graphics page
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Getting to know the Field Assistant interface

A tree item The Graphics page

Configure
Driver Properties .
Module Status Scale to Fit Ctrl+Shift+S

Airflow Config " Details Ctrl+Click
Delete Controller Glbal Modify  Alt+Click
Delete Selected

Reload Control Program

Copy Control Program Properties
Copy Path

A property A trend
¥ Status
Pan Mode
Termin Help B =
M
B . A& Zoom Mode
5 ; . X Scale to fit
Dampes| DEtAIS Ctrl+Click | iy Dack
sunpy | CloPal Modify  Alt+Click |- [ Select Time Range

£ Options
[® Save Graph

? Help

To print the action pane

Click @ at the top of the page to print the contents of the action pane. Set the print orientation to Landscape
in the Print dialog box.

:g: TIPS
L]

To print a Graphics page that exceeds the size of the action pane, right-click the graphic and select Scale to
Fit.

e If you do not want to print the black background, in your browser's Internet Options dialog box, disable
background printing.
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Colors and status in the Field Assistant interface

The following colors indicate equipment status throughout Field Assistant interface. These colors are visible on
Property pages, Graphics pages and in the setpoint graphs.

Color Color Name Status Code Condition Indicated
I Purple Oor15 In a controller—non-operational or no communications
In equipment—a hardware or software error
I Charcoal 14 In a controller—a download is required or is already in
progress
In equipment—a controller has stopped
Coral 13 Control program error
I Red 20r9 Heating or cooling alarm
Orange 8 Maximum cooling
I Dark blue 3 Maximum heating
Yellow 7 Moderate cooling
Light blue 4 Moderate heating
Grey 1 Unoccupied/inactive
White 10 Occupied/active
Light green 6 Free cooling
[ Green 5 In a controller—operational or operational read-only
In equipment—No heating or cooling
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Setting up and configuring your system

On the Devices page > Manage tab, you can:
e Search the network to populate the system with routers and controllers (page 17)
e Upload control programs, drivers, graphics, and screen files (page 21)

e Perform downloads to individual or multi-selected controllers (page 29)

Find and upload routers and controllers

1 Select the system level in the navigation tree.
2 Onthe Devices page > Manage tab, click Find Devices to discover your routers.

3 Once routers are found, select one router at a time in the left-hand navigation tree and click Find Devices
again.

4 Once controllers are found, you must upload content to the routers and controllers. Select one or more
devices in the list on the Manage tab and click Upload All Content to upload drivers, graphics, touch files,
and control programs to the Field Assistant application. Use Ctri+click, Shift+click, or both to select multiple
items.

NOTE If Show Control Programs is checked, all control programs are listed. If you have multiple control
programs in one controller, you will see every control program in the list. If it is not checked, the list only
shows the individual controllers and their model. The same information is uploaded, this option just controls
what you see on the Manage tab and you can toggle back and forth.

5 Click OK when you see the message This will upload all content for the controller. Are you sure you want to
do this?. When complete, a check mark under Status indicates a successful upload.

NOTES
o If an error message appears, click on the message to view an explanation.
o  Uploading can be time consuming, especially for multiple controllers.

o  The MAC address shows to the left of the controller name in the navigation tree only. Programmable
controllers show multiple equipment listings with the same MAC address, based on control programs
downloaded from EquipmentBuilder or Snap.

o  To view the driver names after uploading, select the Advanced tab or right-click the controller in the
navigation tree and select Driver Properties or Module Status.

Q TIPS

e  Click the i symbol 9 in the upper left corner to display the status of the latest operation.
e  Status messages are color coded as follows:

o  Red - reports an error

o  Blue-requires action

o  Green - indicates an upload or download is in process
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Change network and device addressing

The Field Assistant application automatically assigns a BACnet Network IP number and the Device ID for the
application. Do not change these addresses unless absolutely necessary!

NOTE If you have more than 99 routers, you must set your own addresses.
To change an address:
1 Select the system level in the navigation tree and select the Devices page > Advanced tab.
You can change the addressing in these fields:
System level:
o  BACnet/IP network - default is 1600 (The maximum number allowed is 65,534)
NOTE Typically, you should not need to change this.
o  Server Device Id - address of the Field Assistant web server (default is 169998)

o Communications Time-out (in milliseconds) - increase this value only if downloads to controllers or
routers fail with communication time-out errors.

o  Communication Retries (default is 3)

Downloads Devices Alarms

Advanced

BACnet/IP network: Server Device Id: m BACnet Discovery m
Communications Time-out (in milliseconds):
Communication Retries: [3 |

Router level: (Select the router in the navigation tree and select Devices > Advanced.)
o  Router to MS/TP network

o Device Identifier

2  Click Accept.

Set up third-party integration

You can integrate third-party devices into a Field Assistant system if the following are true:

The third-party devices are physically connected on the Field Assistant system’s network.
You have a Carrier controller that supports third-party integration.

You have the correct Carrier driver for the third-party protocol.

You have enabled a port for a third-party protocol on the Carrier controller's driver page.

To read from or write to a third-party device, you need the following information from the third-party vendor:
e  Protocol

e Third-party device’s network address

. Memory location of the object in the device you want to read from or write to

If you are integrating with BACnet devices, you can use the Field Assistant BACnet Discovery (page 19) feature to
gather this information.
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Before you begin a third-party integration, study the Carrier controller’s Installation and Start-up Guides and the
third-party protocol’s Integration Guide. Both are available on the Carrier website (http;//www.hvacpartners.com).

The following Carrier routers let you integrate the allowed number of third-party points into your Field Assistant

system:

This router... Allows this number of non-BACnet third-party points...
i-Vu® Open Link 500

Carrier® Chillervu™ 1000

NOTE The point allowance of the i-Vu Open Link that provides third-party points applies to only itself. For example,
if you download control programs that use 125 third-party Network I/0 points, you cannot apply the unused 125
points to a different router.

To discover third party BACnet networks, devices, and objects

The Field Assistant BACnet Discovery feature locates all accessible BACnet networks, BACnet devices, and BACnet
objects (including devices in your Field Assistant system) on a BACnet network. The information gathered in this
process is typically used to integrate third-party BACnet devices and their BACnet objects into the Field Assistant
system.

To use BACnet Discovery:
1 Select the system level in the navigation tree and then the Devices page > Advanced tab.

2 Click the BACnet Discovery Start button to discover BACnet sites for the system. An item called Discovered
Networks appears in the tree. After all sites are found, close the status dialog box.

3 To discover BACnet networks, select Discovered Networks, then click Go. A list of all BACnet networks
appears in the navigation tree. After all networks are found, close the status dialog box.

Q TIP Run a commstat manual command to determine which device routes to each network. The BACnet
Bind Show Network section of the Commstat window shows the IP address of the router to each network.

4  To discover BACnet devices on a network, select a network in the navigation tree, then click Go. After all
devices are found, close the status dialog box. Click P beside an item to expand the list of devices.

5 Todiscover BACnet objects on a device, select the device on the navigation tree, then click Go. After all
objects are found, close the status dialog box. A list of all BACnet objects in this device appears on the
navigation tree.

Q TIP Make sure you are discovering objects in the correct device. It may take some time to discover
objects in devices with more than 100 objects.

6  Optional: Do the following to export the BACnet information so that it can be used in the Snap application:
a) On the navigation tree, select a discovered network with devices or a single device.
b) Click Export.

¢) Name and save the .discovery file in any folder.
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NOTES

e  Some third-party BACnet devices may not be discovered because they do not support the BACnet methods
required for auto discovery.

° If the discovery process returns ambiguous information, such as multiple points with similar names, contact
the third-party manufacturer's representative for clarification.

e Device configuration or network load can prevent the Field Assistant interface from showing all BACnet
devices. If you do not see a BACnet device that you expect to see, check the system's BBMD configurations. If
the configurations are correct, try the discovery process again.
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Working with equipment in the interface

You can view and adjust equipment operation from the following pages:

Devices pages

Select the System E level on the navigation tree to
view the Devices page, where you can:

e Upload source files or just parameters

° Download source files, schedules, parameters,
or BBMD tables

e  Check status and error messages
e  View model, IP address, drivers, device ID

. Edit device names

Graphics pages (page 51)

You can view and adjust your essential building
controls on most Graphics pages.

Graphics show the current status of mechanical
equipment and may include an adjustable setpoint
control or other editable properties

To upload a graphic from ViewBuilder, double-click
the controller in the navigation tree or right-click and
select Configure.
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Properties pages (page 54)

Each piece of equipment and each microblock has a - i T el
Properties page. You can view and adjust more - .
equipment properties on a Properties page than on

Eouspemiet st Gy [

its corresponding Graphics page. Each microblock
has a Properties page, or pop-up.
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Logic pages (page 59)

Logic pages show the control program for a piece of
equipment. Use the sequence of control and yellow
status values on the Logic pages for troubleshooting
your mechanical equipment.
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Propertles/Microblock popups

To open a microblock pop-up where you can view
and change properties:

e  Click a microblock on a Logic page

° Click the bold, underlined microblock name on
a Properties page

e Right-click a value and then select Detail
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Working with control programs in the Field Assistant interface

The source files given to you by your manufacturer or representative could contain new control programs. If it is a
programmable controller, you might be able to revise it or create a new one in the Snap application.

In the navigation tree, you can double-click the controller, or right-click and select Configure, then select one of
the following options:

e Edit Existing - Downloads programmable controller files to your computer to edit in Snap or EquipmentBuilder

e Add New - Obtains files for the Field Assistant application to add to a controller or to replace an existing
control program

e Update - Changes the control program, view, driver, and screen files to use the current library version. See
Update the equipment library (page 73) for complete instructions

e Delete Unused - Deletes unused control programs

o Reload a revised control program - place the control program in the <local drive>\i-
Vu_Tools_x.x\webroot\<system>\programs folder.
On the Field Assistant navigation tree, right-click the equipment, then select Reload Control Program.
Reloading updates all instances of a control program throughout the system and marks the controller(s) for
download. Field Assistant determines the appropriate download option (page 30) based on what changed in
the control program.

You can use EquipmentBuilder or Snap to create your control programs (.equipment files).

e  EquipmentBuilder can also produce a graphic (.view file), BACview® file, touchscreen file, and a sequence of
operation, based on the equipment options you select.

e [f using Snap, you must create your graphics separately in ViewBuilder. See Snap Help for detailed
instructions on creating a custom control program.

After creating your control program, load it into Field Assistant and download it into the controller. See Add or
delete a custom control program to a controller and to Field Assistant (page 24).

NOTE If you change a control program in the Snap application and it does not display correctly in the Field
Assistant interface, Ctrl+right-click the Field Assistant action pane, and then select Refresh.

To edit a control program

You can edit a control program in the Snap application and add it to a controller.

To get the control program to be edited
Right-click the equipment on the Field Assistant navigation tree, then select Configure.
In the Control Programs section, click Edit Existing.

Click Save as.

1
2
3
4 Browse to the folder you want to put the file in.
5 Click Save.

6  Click Close.

Edit the control program in the Snap application. See Snap Help for more information.

NOTE Be sure to save it with a different name.
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To put the edited control program back in your database

Right-click the equipment on the Field Assistant navigation tree, then select Configure.
In the Control Programs section, click Add New.

Browse to select the control program.

Click Open.

Click Continue.

Click Close.

~N o g b~ WN P

Click Close again.

To download the edited control program to your controller(s)

Click . See Downloading to controllers (page 29).

Add or delete a custom control program

To save time when testing custom control programs, you can use Debug Mode (page 80) in the Field Assistant
interface. for one controller at a time.

& CAUTION Never leave your Field Assistant system without unchecking DEBUG MODE first and and then
downloading all content. The source files are not in the controller until you complete both steps.

To add a new control program to a programmable controller
1 Select the router in the navigation tree.
2  Select Devices > Manage tab.

3 Select the controller in the list on the page.

4 If you are adding a new control program, click the Add Control Program button. A dialog
window appears.

5 Enter a name for your control program in Display Name and select your controller in the Controller drop-down
list.

NOTES

o If you already have the maximum number of control programs for a controller, it will not appear in the
list.

o  Optional: You can change the control program's Reference Name if needed.
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6 Do one of the following;:

If the control program is...
In the Control Program drop-down list Select the control program.

Not in the Control Program drop-down list a. Click Add New.

b. Browse to select the control program.
c. Click Open.

d. Click Continue.

e. Click Close.

7  Toupload a graphic, click Add New under Views and browse to your .view file.
8 Click Continue. When message appears File added successfully, click Close.
9 Click Close again.

10 Right-click on the programmable controller in the controller list and select Check Status from the list. The
status of the controller should say File Mismatch.

11 Click the Download All Content (page 29) button.

NOTE If you need to edit the Object Instance, right-click the control program in the navigation tree and then select
Configure. Click 6 next to the field for additional information.

To delete a single control program in a programmable controller
1 Select the router in the navigation tree.

2  Right-click the the desired controller/control program in the list on the Devices page > Manage tab and click
Delete Selected from the list.

3 The message appears Do you wish to remove a controller and all its descendants? Click OK.
IMPORTANT! The process is not finished until you complete the following steps.

4 Highlight the programmable controller in the controller list again, and select Check Status. The status of the
controller should say File Mismatch.

5 Click File Mismatch and click the Download button. This deletes the files from the controller.

To delete all control programs in a programmable controller
1 Select the router in the navigation tree.

2 Right-click the desired controller/control program in the list on the Devices page > Manage tab and select
Delete Programs. Click OK when the following message appears This will delete all programs in this
controller. Are you sure?

IMPORTANT! The process is not finished until you complete the following steps.

3 Highlight the programmable controller in the controller list again, and select Check Status. The status of the
controller should say File Mismatch.

4 Click File Mismatch and click the Download button. This deletes the files from the controller.
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Working with drivers in the Field Assistant interface

You can make the following changes to a driver in the Field Assistant interface.
e Change or upgrade a driver. See topic below.

e Reload a driver if it becomes corrupt (for example, a driver page is missing). On the Field Assistant navigation
tree, right-click the controller or driver, then select Reload Driver. Reloading updates all instances of the
driver throughout the system and marks the controller(s) for an All Content download. Changes you made on
the driver pages in Field Assistant remain in effect.

After you make these changes, you must Download All Content (page 29) to the affected controller(s).

To change or upgrade a driver

1 On the Field Assistant navigation tree, right-click the controller, then select Driver Properties > Update tab.

2 If other controllers in the system use this driver, select which controllers you want to change.

@ This controller only
All controllers on this network that use same driver version
All controllers in the system that use same driver version

3 Do one of the following:

If the driver is...

In the Driver Version drop-down list a. Select the driver.
. Click Accept.
. Click Add.

(o

Not in the Driver Version drop-down list

o 9

. Browse to select the driver.

. Click Open.

o o

. Click Continue.
. Click Close.

oo

. Click Close again.

4 Download All Content (page 29) to the controller.

NOTE You can click Delete Unused in the Controller section to delete all unused drivers in i-
Vu_Tools_x.x\webroot\<system_name>\drivers.
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Working with screen files in the Field Assistant interface

To use an Equipment or System Touch, or BACview®, to view or edit a controller's property values, you must
download a screen file (.touch, .bacview, .S37, or.kpd) to the controller.

To select a different screen file

1 Onthe Field Assistant navigation tree, right-click the controller, then select Driver Properties > Update tab.

2 If other controllers in the system use the current screen file, select which controllers you want to change.

(@ This controller only
All controllers on this network that use the same screen file

All controllers in the system that use the same screen file

3 Do one of the following:

If the screen file is...

In the Screen file drop-down list a) Select the file.
b) Click Accept.
Not in the Screen file drop-down list c) Click Add.
d) Browse to select the screen file.
e) Click Open.
f)  Click Continue.
g) Click Close.
h) Click Close again.

4 Download All Content (page 29) to the controller.

NOTE You can click Delete Unused in the Screen File section to delete all unused screen files.

To edit a screen file

You can get a copy of a screen file from Field Assistant, edit it and then put it back into your Field Assistant
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system.

To get the screen file

1 Onthe Field Assistant navigation tree, right-click the controller that uses the screen file, then select Driver
Properties > Update tab.

Under Screen File, click Edit.

Click Save.

Browse to the folder you want to put the file in.
Click Save.

o g~ WN

Click Close.

To put the edited file back on the server

1 Onthe Field Assistant navigation tree, right-click the controller that uses the screen file, then select Driver
Properties.

Under Screen File, click Add.
Browse to select the file.
Click Open.

Click Continue.

Click Close.

~N o o b~ WN

Click Close again.

BACnet device tools and services

The tools and services described below let you control or troubleshoot BACnet devices. To access the tools and
services, click on the BACnet router on the Field Assistant navigation tree, then click Properties.

Tool Description
Module Status Generates a Modstat report. See Using a Modstat to troubleshoot your system (page 82).
Show Bindings Displays all Device IDs that the BACnet device communicates with and the network

address of each device.

BACnet device services
Although the following BACnet device services can be used for Carrier controllers, you should not need to use
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them for this purpose. Their primary target is a third-party device that supports these services.

Service Description
Time Sync Sends the site's local time to the BACnet device.
UTC Time Sync Sends the Coordinated Universal Time (UTC) to the BACnet device. The device must be

able to convert the time to its local time zone.
NOTE Some devices support only one of the above time sync services.

Backup, Restore, Executes a BACnet Backup or BACnet Restore service as defined by the BACnet
and Abort standards. A message appears when the backup or restore is complete.

Click Abort to stop a Backup or Restore.

NOTE These services are vendor-specific and should be used with caution. A failed
restore could make a device inoperable. Before using these on a device running in a live
system, test them on the device during installation.

BACnet Password Applies to Backup, Restore, Warmstart, and Coldstart. Enter your BACnet password if
required by the BACnet device. This password is typically defined in a third-party tool.

Warmstart or Restarts the BACnet device.

Coldstart ) ) . .
For a third-party device, see the manufacturer's documentation to determine the
difference between these 2 services.

For Carrier controllers, these services are the same. These services will cycle the
controller's outputs.

DCC Use to stop or start the BACnet device's communication. Select one of the following
options in the droplist, then click DCC.

Enable Starts the device's communication.

Disable Stops the device's communication for the amount of time that you
enter in the Timeout field. See NOTE below.

Disable Stops the device from initiating communication for the amount of time
Initiation that you enter in the Timeout field. See NOTE below. The device will
continue to respond to communications from other devices.

NOTE Type -1 in the Timeout field to disable communication indefinitely. Normal
communication will resume only when the device receives an Enable command.

Event Info Displays detailed information about the objects that are currently in alarm.

Event Summary Displays summary information about the objects that are currently in alarm.

Downloading to controllers

If you make any of the following changes, you must download the new data from the Field Assistant application to
the affected controllers.
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Change or reload a control program
Change or reload a driver

Change a schedule

Change a screen file

In the Field Assistant
interface

The Field Assistant application automatically marks the affected controllers as requiring a download. You can
download these controllers from the the Devices (page 31) page or the Properties (page 31) page for the
controller, the equipment, or a microblock.

When the Field Assistant application marks a controller for download, it determines what information needs to be
downloaded based on the type of information that changed. See Download Options (page 30).

By default, Full Source files are downloaded to i-Vu® Open PIC controllers because Optimize download for Open
PIC controllers is unchecked on the Devices > Advanced tab (from the system level in the navigation tree). Check
this option if you do not want Full Source downloaded.

& CAUTION If you want this option checked and purposely had it checked in your previous system, it is
automatically unchecked after upgrading and you must check it again.

NOTE A property change in the Field Assistant interface is automatically downloaded to the controller. If the
download fails, the controller is added to the Downloads page with the reason for the failure.

Download Options

When Field Assistant marks a controller for download, it determines what information needs to be downloaded
based on the type of information that changed. Below are the options that can be downloaded.

This option... Downloads...

All Content ¢ Control programs
e Graphics
e Drivers

¢ BACview® files
¢ Touchscreen files
e Parameters

e Schedules

NOTE An All Content download also:

¢ Synchronizes the controller's time to Field Assistant
¢ QOverwrites trends in the controller

* Restarts the controller

Only Schedules All schedules that are not set for automatic download
Only Parameters All editable properties
Only BBMDs BBMD tables (.bdt file) that you have updated but have not yet written to the controller

NOTE An All Content download clears trend, history, and alarm data from the affected controllers.

To upload or download parameters only

This option uploads all editable properties from the device, but not the source files. If you edit the properties on a
controller that is not physically connected to the computer, you will have to either upload or download parameters
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when you connect again. Upload to get what is in the controller into Field Assistant or download to send your
changes in Field Assistant to the controller.

To download from the Devices page

The System E level Devices page shows any controllers that Field Assistant marked for download.

To download:

1 On the navigation tree, select the System E or router to download controllers that you are connected to.
2  Select the controllers that you want to download.
NOTE Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers.

3 Click Download. A message appears This will download programs and other content for the entire controller
and restart it. Are you sure you want to do this?

4 Click OK.

NOTES

£ L.
e  Active uploads 1" and downloads"E»‘ cannot be stopped.
e |cons in the Status column indicate the following:

ap Active—Field Assistant is uploading to the controller.
E, Active—Field Assistant is downloading to the controller.
ﬁ'_} Pending—You initiated the download, and the controller is waiting for its turn to download.

X Failed—The download failed. See If a controller fails to download (page 31).

On Hold—Indicates you clicked Hold to stop a pending ﬁ'} download.

Click ﬂ in the upper left-hand corner to view a log of download activity in the current session. Copy to Clipboard
lets you copy the text to paste it into another application.

To download from a Properties page

If a controller requires a download, a red download message and a Download button appear at the top of the
Properties page for the controller, the equipment, or a microblock. Click the button to start the download.

Downloading from the Properties page downloads All Content to the controller.

If a controller fails to download

A controller that fails to download appears on the Downloads page or Devices page > Manage tab with this icon
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1 Review the reason for the failure:

o  Hold your cursor over the failed task to see hover text giving the reason.

o  Click ﬁ or X in the upper left corner of the page to see information on all failed downloads. Copy to
Clipboard lets you copy the text to paste it into another application.

2  Correct the problem that caused the failure.
3 Select the controller that you want to download.

NOTE You must be connected to the controller to download.

Checking controller status

On the Field Assistant navigation tree, you can select a router or the System level, and then click Devices to:
e View the status of controllers (page 32)

e  Onthe Manage tab, you can view controller information such as address and model. On the Advanced tab,
you can view the driver and device ID.

e  Download or upload to resolve a mismatch

Status messages

On the Devices page > Manage tab, the Status column shows a description of the devices's current state. Hold
your cursor over the Status description to see hover text with a more detailed description. If multiple conditions
exist, Field Assistant displays the message with the highest priority.

To see the Status messages:
e On the Field Assistant navigation tree, select the System level to view the status of routers.

e On the Field Assistant navigation tree, select a router to view the status of its controllers.

The table below shows all possible messages. The message color indicates the following:

Black—In process
Red—An error occurred
Blue—Requires action from the user

Status column message Hover text message Notes
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Black messages:

Downloading

Uploading

Pending

Red messages:

Communications Error

Connection Disabled

Connection Error

Controller Disabled
Controller offline

Download Failed

Download Not Permitted

Error

Missing Files

Not Uploadable

Out of Service

Unsupported Controller

Upload Not Permitted

Blue messages:

Controller Replaced

Download All Content

Field Assistant v6.5

Hover text message

The controller is downloading,
communications may be disabled

The controller is uploading,
communications may be disabled

This controller is waiting to be processed.

Cannot communicate with this controller.

The connection for this controller has been
disabled.

The connection for this controller failed to
start.

This controller has been disabled.
The controller is offline.

(Message depends on the cause of the
failure.)

This controller is not permitted to
download.

An unknown error has occurred.

Upload failed. Server is missing source
files.

This controller is not configured for
content upload.

This controller is out of service.

This controller does not support content
upload.

This controller is not permitted to upload.

This controller has been replaced by
another controller of the same type in the
field.

Please download all content to the
controller.

Carrier Proprietary and Confidential

33

Working with equipment in the interface

Notes

Occurs if someone stopped the
connection.

Occurs if the connection is
misconfigured or failed to start.

Occurs if you attempt to upload a
controller with a pre-4.x driver.

Out of Service is checked on the
controller's Properties page.
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Status column message

Download Parameters

Download Schedule

Driver Parameter
Mismatch

Network Ready to Find

Devices

Parameter Mismatch

Program Mismatch

Unprogrammed
Controller

Upload All Content

General messages:

v

Cancelled

Hover text message

To download parameters, highlight row
and select "Only Parameters" from the
Download Action menu and click
"Download"

To download schedules, highlight row and
select "Only Schedules" from the
Download Action menu and click
"Download".

Driver parameter differences detected.
Upload parameters from the controller or
download parameters to the controller.

To upload this network, select the router in
the tree and click Find Devices button.

Control Program parameter differences
detected. Upload parameters from the
controller or download parameters to the
controller.

Content differences detected. Upload all
content from the controller or download all
content to the controller.

This is a programmable controller. To add
control programs, click Add Control
Program.

Please upload all content from the
controller.

This controller is ok.

The last operation on this controller was
cancelled

Handling parameter mismatches

Notes

See Handling parameter mismatches

(page 34).

A parameter mismatch occurs when a value in a controller does not match the value in the system database. This
can be a driver or control program value.

To find mismatches in your system

You can find mismatches in the following places:

e The Devices page > Manage tab > Status column will show Parameter Mismatch.

e  The Properties page for a controller, driver, control program, or point will show one of the following red
messages at the top of the page stating:

Control Program parameter differences detected.
Driver parameter differences detected.
Parameter download required.
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The value that has a discrepancy will appear with a purple box around it. Hover your cursor over the field to
see:

Parameter needs downloading

Database value: Enable
Controller value: Disable

NOTE The Downloads page > Tasks column will show Resolve Parameters for any mismatches that your
system discovered in the 3 places listed above.

To resolve a mismatch

1 Go to one of the following:

e Devices page - Click the Parameter Mismatch link
e  Properties page that shows one of the red messages above

2 Click one of the following:

o Resolve to let the Field Assistant application download changes made in the Field Assistant interface or
upload changes made in the controller. Click the Details button to see what the discrepancy is and
whether Resolve will download or upload parameters. See NOTE below.

Expression Database | Resolve | Controller

Download
Upload

o  Upload to upload the parameters from the controller to the Field Assistant application

o Download to download the parameters from the Field Assistant application to the controller

NOTE On the Devices page with Show Control Programs unchecked, if a controller has simultaneous
mismatches in the driver and control program, clicking Details will show that a control program mismatch
exists but it will only show details for the driver mismatch. You must go to the control program in the tree to
see details of that mismatch. However, clicking Resolve will resolve both mismatches.

Managing setpoints

The Setpoint graphic shown on a standard equipment graphic indicates the base setpoint values (Occupied
High/Low, Unoccupied High/Low). The Field Assistant application reads these values back periodically, typically
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within 10 seconds. The timing can vary based on network traffic, the number of controllers in the database, and

several other variables. Setpoints that are changed in the field via another user interface are displayed in the Field
Assistant interface as soon as they are detected.

You can, at any time, change the setpoints from Field Assistant graphics by using the slider or by entering numeric
values directly. Updated setpoints are transmitted to the controller when you Accept the changes. Setpoints can

also be changed on the Properties page > Control Program tab > Space Temperature and Setpoints. or
Configuration > Setpoints.

The various color bars indicate adherence to or deviation from the setpoint. You can change the current default
settings for setpoint deviation. Select a color band on the setpoint graph to see the current setpoints in the
Heating and Cooling fields. The values in this graphic are Fahrenheit. See setpoint descriptions below.

NOTE This graphic is an example only. Your setpoints may differ.

Setpoints
Demand 3

Demand 2
Demand 1
Occupied

Unoccupied

Color

Field Assistant v6.5
Help

Green
Grey

Light Blue

Dark Blue

Yellow

Orange

Red

Condition

To change a sepoint,
type the number here,

or

slide th

Temperature is within the Occupied Low and High Setpoint

Temperature is within the Unoccupied Low and High Setpoint

Temperature is less than 2°F below the Occupied Low

Setpoint

Temperature is more than 2°F below the effective Low
Setpoint but less than 4 °F below the effective Low Setpoint

Temperature is less than 2°F above the effective High

Setpoint

Temperature is more than 2 °F above the effective High
Setpoint but less than 4°F above the effective High Setpoint

Temperature is more than 4 °F above or below the effective

setpoints
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w space temp

OCCUPIED Heating | 70.00 Cooling |74.00

| 4
1N i I

Adjust setpoints

e  Programmed setpoints are set and changed by operators.

o  Effective setpoints reflect the impact of other system conditions on the programmed setpoints, such as
setpoint adjustments, and hysteresis. Effective setpoints control the equipment.

To change programmed setpoints:

1 Navigate to a setpoint control in one of the following places:
o  Properties page > Control Program tab > Configuration > Setpoints
o  The setpoint microblock pop-up on a Logic page

o A Graphics page (Click a setpoint trend graph control to access the editable setpoint bar.)
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2 Make changes on a programmed setpoint bar by either:
o  Clicking and dragging the segment or the gap between segments
o  Typing new values in the Heating and Cooling fields

3 Click Accept.

Demand Control

Demand Control is a cost-saving strategy that saves energy while maintaining comfort in the following ways:
e  Controlling energy use to avoid peak demand, ratchet, or time of use utility charges

e Maintaining ventilation at relaxed setpoints rather than shutting down equipment (as with load shedding or
duty cycling)

Before you can use Demand Control effectively, you must:

e  Obtain details regarding past energy usage and peak demand, ratchet, and time of use charges from your
energy provider.

e Understand the demand profiles of the zones you are controlling.

Demand Control can be customized at the zone level. For example, you may relax the setpoints in some zones,
like break rooms and closets, by a few degrees, but you may not want to relax setpoints in computer rooms at all.

Relaxed Relaxed

heating coaling

setpoint setpoint
66,00 a0.00

Dermand 3
Cemand 2
Derand 1
Qccupied

Unococupied

— —
ALARH  COOL IDEAL HARH  ALARH

To define Demand Control properties
1 On the navigation tree, select the electric meter.
2  Select Properties > Control Program and expand the Demand Level Parameters section.

3 Type the Start and End time to define the time period that you want demand control to be in effect for this
zone.

4 Type kilowatts per hour (kW/hr) in the Level columns to define the amount of power that the demand must
exceed before the Field Assistant system calls for a higher demand level.

NOTE Levels are defined in the electric meter control program in the Snap application. You can test the Demand
Levels by locking the meter to a value.
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In the example below, during Period 4, defined as 12:00 (noon) to 16:00 (4:00 p.m.), if the demand exceeds 800
kW/hr, the Field Assistant system will use Demand Level 1 setpoints. If the demand exceeds 1000 kW/hr, the
Field Assistant system will use Demand Level 2 level setpoints and so on.

¥+ Demand Level Pammeters

Curmrent Demand Level: 0

Period  Start (hhimm) End (hinomm) Level 1 (kW) Level2 (kW) Level3 (kW)

1 | of| 0o aff 00 980 11500 1800 |
2 4| 00| 8l 00 950 1400 1650

a 8/ 00 12/ 00 875 | 1200 11375 |
|4 12} 00| 16/| 00| 800 | 1000 1200| |
5 16| 00 20f| 00 900 1300 1450

6 : 24{| 00 1000 1550

Configuring Optimal Start

Enable and configure Optimal Start on the Properties page > Control Program tab > Configuration > Setpoints.
Your control program could be configured for Optimal Start or for both Optimal Start and Optimal Start Type.

NOTES
e The Optimal Start options depend on the revision date of the control program in your controller.

e  Optimal Start is automatically disabled when Properties > Control Program > Maintenance > Occupancy >
BAS On/Off is set to either Unoccupied or Occupied.

Optimal Start

Optimal Start adjusts the effective setpoints to achieve the occupied setpoints by the time scheduled occupancy
begins.The Optimal Start recovery period may begin as early as 4 hours prior to occupancy. The algorithm works by
moving the unoccupied setpoints toward the occupied setpoints. The rate at which the setpoints move is based on
the outside air temperature, design temperatures, and capacities.

The following conditions must be true for optimal start to operate:

e  On the Properties page > Control Program tab > Configuration > Setpoints > Optimal Start, the Default
Value must be set greater than 0 and less than or equal to 4 (0.00 disables Optimal Start).

e  The system is unoccupied

NOTE If the Open controller does not have a valid outside air temperature, then a constant of 65° F is used. This
value is not adjustable.
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The actual equation that the controller uses to calculate Optimal Start is nonlinear. An approximation of the result
is shown below.

To change Optimal Start settings:
1 Inthe navigation tree, select the equipment that you want to change.

2  Select Properties page > Control Program tab > Configuration > Setpoints.

Optimal Start Type

If you have Optimal Start Type, you must choose from the following:
° None
o  Temperature Compensated Optimal Start

e Learned Adaptive Optimal Start

To select the method used to change from unoccupied to occupied setpoints:
1 Inthe navigation tree, select the equipment that you want to change.

2  Click Properties page > Control Program tab > Configuration > Setpoints.
3 Select option from the Optimal Start Type drop-down list.
4

See below to make further adjustments.

None - The unit will not start to control to the occupied setpoints until the unit goes into an occupied mode.
Setpoints do not ramp, but change immediately from unoccupied to occupied values. When you select None, you
must set all Learning Adaptive Optimal Start transition factors, identified by their themographic color, to 0. These
are located directly above the Effective Set Points graph.

Temperature Compensated - The unit changes to occupied setpoints at some time prior to the occupied time, not
to exceed the hours you set for Optimal Start. The start time is determined by the current error between space
temperature and the appropriate heating or cooling setpoint. At that time, the setpoints do not ramp, but change
immediately from unoccupied to occupied values. When selecting Temperature Compensated, you must set all
Learning Adaptive Optimal Start transition factors, identified by their thermographic color to 0. These are located
directly above the Effective Set Points graph.
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When selecting Temp Compensated, you can adjust the following:

o Heat Start K factor (min/deg) - If Optimal Start Type is Temp Compensated, this is the time in minutes per
degree that the equipment starts before the occupied period when the space temperature is below the
occupied heating setpoint (including any setpoint offset).

e Cool Start K factor (min/deg) - If Optimal Start Type is Temp Compensated, this is the time in minutes per
degree that the equipment starts before the occupied period when the space temperature is above the
occupied cooling setpoint (including any setpoint offset).

NOTE The default value for the above is 15.00 and the range is O to 99.

Learning Adaptive Optimal Start - This function gradually adjusts the unoccupied setpoints over a specified
period of time to achieve the occupied setpoint by the time scheduled occupancy begins. This learning adaptive
algorithm uses the learned heating capacity and learned cooling capacity values to calculate the effective
setpoints prior to the occupied start time. The algorithm calculates a learned cooling and heating capacity during
the previous unoccupied time. Set the Learning Adaptive Optimal Start recovery period from 1 to 4 hours in
Optimal Start. When the Learning Adaptive Optimal Start routine runs, adjustments are based on the color that is
achieved when occupancy begins. Adjustment amounts are defined in the thermographic color fields located
directly above the Effective Setpoints graph under Setpoints.

EXAMPLE The heating capacity for a zone is 5° per hour (default). When the zone becomes occupied, the zone
temperature is 1° below the occupied setpoint, indicating a need for additional heat. Because the zone
temperature was low by 1°, the learned heating capacity is decreased by the value entered in the LtBlue
thermographic color field (0.0600 default). As a result, the learned heating capacity is adjusted to 4.94° for the
next optimal start period. Since the algorithm has calculated that the equipment has less capacity to bring the
temperature to setpoint within the configured recovery period, the setpoint adjustment begins sooner in the next
unoccupied period.

To change the adjustment values in the Learning Adaptive Optimal Start routine:
1 Inthe navigation tree, select the equipment that you want to change.
2 Click Properties page > Control Program tab > Configuration > Setpoints.

3 Adjust the color fields between the Zone Setpoints graph and the the Effective Setpoints graph.

When you determine that no further start time optimization is required, you can disable Heating and Cooling
Capacity adjustments by setting the color field values to 0.0.
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You can reset the learned heating and cooling capacities by entering a value into either the Heating Capacity or
Cooling Capacity, located beneath the Zone Setpoints graph.

Allows learned cooling
and heating capacities
to reset.

Thermographic color fields
—determine the adjustment
factors for Learning Adaptive
Optimal Start.

Sets the maximum
allowable recovery period.

Selects the type of Optimal
Start algorithm.

& CAUTION When using Learning Adaptive Optimal Start, be sure that all equipment is properly maintained so
that your system does not “learn” to compensate for dirty filters or loose fan belts.
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Commissioning equipment

Follow the process below to commission system equipment.

Step 1: Check out point setup

1

w

~N o o b~

On the Field Assistant navigation tree, select the piece of equipment you want to check out.
Click Properties.

View and change properties on the 1/0 Points, Alarm Sources, Trend Sources, Network Points, BACnet
Objects, and Rnet Points tabs. See "Property descriptions" below.

After completing the equipment checkout, click the Checkout tab.
Select Checked Out. This field is for your reference only.
Optional: Type notes. Notes remain in this field until an operator deletes them.

Optional: Click the Reports drop-down arrow, then select and run each of the following reports to verify your
work:

o  Equipment > Point List
o  Alarms > Alarm Sources

o  Equipment > Network 10

_Q_TIP You can export the calibrated data so that you can import it into another control program. See Optional:
Import/export calibration data (page 49).

Property descriptions
1/0 Points
Name Click the name to display the microblock pop-up.

NOTE A red name indicates a fault condition where the point may be misconfigured.
EXAMPLE No input/output number or a nonexistent input/output number.

Type Type of Input or Output point.

Value The point's present value.

Offset Allows for fine calibration of the present value of an analog point.

Polarity Determines the point’s binary normal polarity in the control program.
NOTE Polarity is not the hardware normally open/normally closed position.

Locked Select the checkbox to lock the present value at the value you specify.

Exp:Num Expander numbers and input or output numbers associated with where the physical point
wires, such as a sensor wire, are physically connected to a controller.

/0 Type Selects the bank of physical inputs or outputs on the controller.
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Sensor

Actuator

Resolution

Checked Out
Checkout Notes

Alarm Sources
Name

Type

Alarm

Network Visible
Potential alarm

source

Alarm Enabled

Requires ack

Critical

Category

Field Assistant v6.5

Help

Selects how the physical input is mapped to the engineering units.

Min/Max is used with the sensor type of linear to scale the input to engineering units.
NOTE This field is ignored for sensor types other than linear.

EXAMPLE: Al linear sensor type
min -10
max 50
when input reads 100% the value is 50
50% 20
0% -10

Selects how the present value in engineering units is mapped to the physical output.

Min/Max is used with the actuator type of linear to scale the output from engineering
units.
NOTE This field is ignored for actuator types other than linear.

EXAMPLE: AO linear sensor type
min -10
max 50
when input reads 50 the output is 100%
20 50%
-10 0%

Amount by which the present value will change.

EXAMPLE If a physical input changes by 1, but the resolution is set at 2, then the present
value remains the same. If the input changes by 2, the present value will then change by
2.

These fields are for your reference only.

Click the name to display the microblock pop-up.

Type of point that is an alarm source.
Shows Alarm in red if a current alarm exists.

Select to allow the microblock to be seen by the Field Assistant application and third-party
BACnet controllers on the network.

Select to enable the microblock to generate alarms.

Alarm—Select to generate an alarm when conditions exceed the limits set in the Condition
column.

Return—Select to generate a return-to-normal message when the alarm condition returns
to a normal state.

Fault—Select to have an alarm generated if the alarm source is not configured correctly.
For example, a misconfigured channel number produces a no sensor fault.

Alarm—Select to require that the alarm be acknowledged.
Return—Select to require that the return-to-normal message be acknowledged.

Select if the alarm is critical.

You can change the alarm category assigned to the microblock.
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Condition

Delay

Trend Sources

Name

Type

Sample Interval

COV Increment

Network Points

Name

Type

Value

Locked

Default Value

Com Enabled

Field Assistant v6.5

Working with equipment in the interface

An alarm will be generated if conditions exceed the low or high limits set.

Deadband:
The amount inside the normal range by which an alarm condition must return before a
return-to-normal notification is generated.

EXAMPLE

High:gzﬁ—pﬂv&—nvm_n shand
215 - = Leadban
- I 10 = Deadband

Low= -25 = Deadban

® Alarn is generated
= Return-to-Mormal is generated

Delay time in seconds for notification after an alarm is generated.

Click the name to display the microblock pop-up.

NOTE A red name indicates a fault condition where the point may be misconfigured.
EXAMPLE No input/output number or a nonexistent input/output number.

The type of point being trended.

The interval or COV (Change of Value) increment that triggers the trend sample.

The increment, or interval, that triggers the trend sample on Change of Value

Click the name to display the microblock pop-up.
NOTE A red name indicates a condition where the point may be misconfigured.
Type of network point.

The point's present value.

EXAMPLE For a Maximum point type, Value is the maximum value of all the target BACnet
object properties the point is communicating with.

Select the checkbox to lock the present value at the value you specify.

The value that the control program will use as the point’s value when communication with
the target defined in the Address column is lost or communication is disabled.

Select to enable this point’s network communications. Disable this property for
troubleshooting.

NOTE Select All in the column header to quickly enable all points in the control program.
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COV Enable

Refresh Time
(mm:ss)

Address

Error

Present Value

Working with equipment in the interface

Select to make:

e Adigital network output point write a value to the target defined in the Address
column only when the value changes.

e An analog network output point write a value only when the value changes by the
specified increment.

The time interval at which the network point writes or retrieves the value to or from the
target. For network output points, this time is used when COV is not enabled or when COV
is enabled but fails.

NOTE If COV fails and the Refresh Time is zero, the value is sent once per second.

The address of the target BACnet object property or third-party value that the point
communicates with.

NOTE Click Search/Replace at the top of the Address column to have the Field Assistant
application replace all instances of specific text in the addresses with different text. This is
especially useful when copying a control program to use for multiple third-party devices.

The error code and error if the point cannot communicate with the target.

Current value of the target defined in the Address column.

Checked Out These fields are for your reference only.
Checkout Notes
Notes typed in this field appear in the Equipment Points List Report.
BACnet Objects
Name Click the name to display the microblock pop-up.
NOTE A red name indicates a condition where the point may be misconfigured.
Reference A unique identifier that allows the point to be referenced for used for graphics, source tree
nhame rules, or network links.
Type The BACnet object type.

Present Value

The object's current value.

Locked Check to lock the third-party object to a specific value.

Device A device alias. See "To reuse a control program" in Device Alias (page 220).

Object Name An alpha-numeric string that is unique within the third-party device.

Object ID A combination of the object type and a unique instance number. The object ID must be
unique within the device.

Address The address of the third-party object that the microblock references.

Network Visible Allows other BACnet equipment to read or change the microblock's present value. Must be

enabled for this microblock to generate alarms.
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This tab shows varying information for the different point types. Below are all possible properties that may appear
on this tab and a list of the applicable points. The following list is arranged alphabetically.

Combination
Algorithm

Default Value

Display
Resolution

Edit Increment

Editable

Lock Present
Value to

Maximum

Menu
Configuration

Minimum

Minimum off
time

Minimum on
time

Object Id

Object Name

Reference name

Rnet Tag

Field Assistant v6.5

(Analog Sensed Values)
The method used to combine the ZS sensors' values to determine the microblock's
output value.

(Analog Parameters, Binary Parameters, Multi-State Parameters)
The value the control program uses until a user changes the value in the system
interface.

(Analog Sensed Values, Analog Statuses, Analog Parameters)

Defines the resolution of the value to be displayed on the ZS sensor. For example, 1
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 (example:
74.5).

(Analog Parameters)

The amount that you want each press of the sensor's A or v button to change the
microblock's value.

(Analog Parameters, Binary Parameters)
When enabled, the microblock's value is editable on the ZS sensor.

(Binary Parameters)
Check to output the locked value from the microblock instead of the microblock's
calculated value.

(Analog Parameters)
The highest amount that this value can be changed to on the ZS sensor or in the Field
Assistant interface.

(All points)
Shows which sensor screens display the value.

(Analog Parameters)
The lowest amount that this value can be changed to on the ZS sensor or in the Field
Assistant interface.

(Binary Parameters)
The minimum period (seconds) that the microblock sends an off signal to the controller,
regardless of the input signal to the microblock.

(Binary Parameters)
The minimum period (seconds) that the microblock sends an on signal to the controller,
regardless of the input signal to the microblock.

(All points)
A combination of the object type and a unique instance number.

(All points)
A unique alphanumeric string that defines the BACnet object. Although the Object Name
field can be edited, it is not recommended.

(All points)
A unique identifier that allows the point to be referenced for used for graphics, source
tree rules, or network links.

(All points)
Defines what type of information this value represents and determines how the sensor
will display the value. For example, for the Rnet Tag Fan Status, the sensor automatically

displays * on the Home screen when the microblock is active.
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Show on sensors  (Analog Sensed Values)

Defines whether the ZS sensors are to display their individual sensed values, or the value
determined by the Combination Algorithm.

Type (All points)

Type of Input or Output point.

Value (All points)

The point's present value.

Protocol Mapping

If a control program was built with Protocol Mapping information in Snap, this tab will appear showing third-party
protocol configuration information.

Step 2: Check controller to sensor wiring

PREREQUISITE On the Logic page, disable the run condition(s) in the control program to prevent control program
execution from affecting output values while you check out the equipment.

Binary inputs (BI)

1
2
3
4
5

Short the binary inputs wires at the end device, for example, at a pump proof or fan proof.
On the Properties page 1/0 Points tab, verify the binary input point is closed.

Open the binary input at the end device.

Verify the binary input point is open on the Properties page.

Repeat for all binary inputs.

NOTE If the readings on the Properties page are reversed from actual conditions, the polarity (normally
closed/normally open contact position) is set incorrectly.

Analog inputs (Al)

1

2
3
4

Verify the sensor type and the min/max values are configured correctly.
On the Properties page 1/0 Points tab, read the analog input value.
Short the point. The sensor should go to full range when shorted.

Calibrate analog input value by adjusting the calibration offset if needed.

Binary outputs (BO)

1

o 0o b W N

If the controller's binary output is wired through an equipment starter, set the starter HOA switch to
Automatic.

On the controller, set the binary output’s HOA switch to On.

Verify that the controlled equipment has turned on.

On the controller, set the binary output’s HOA switch to Automatic.

On the Properties page I/0 Points tab, lock the binary output point to On.

Verify the device has turned on.
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7 Unlock the binary output point.
8 On the controller, set the binary output’s HOA switch to Automatic.

NOTE If the locked conditions on the Properties page are reversed from actual conditions, the polarity (normally
closed/normally open contact position) is set incorrectly.

Analog outputs (AO)

Verify the output/actuator type and the min/max values are configured correctly.
Lock the analog output point to the device minimum output, such as 2 volts or 0%.
Verify movement of the end device to the desired position.

Lock the voltage output to the device maximum, such as 10 volts or 100%.

Verify movement of the end device to the desired position.

Unlock.

o 0 b~ W N P

Step 3: Check equipment operation

Refer to the sequences of operation in the system specifications to verify that the equipment operates in each
operational mode (for example, occupied and unoccupied) as specified.

797TIP If needed, you can import calibration data that you exported from another control program. See Optional:
Import/export calibration data (page 49).

Optional: Import/export calibration data

You can export I/0 point calibration data from a control program and import it into the same control program or
another control program with the same I/0 point configuration.

To export calibration data

1 Onthe Field Assistant navigation tree, select the control program whose data you want to export.

2 Scroll to the bottom of the Properties page I/0 Points tab, and then click Export. The file <control program
name>_<ref name>.xml is saved in your browser's Downloads folder.

To import calibration data

NOTE We recommend that you export existing data as a backup before you import new data.

1 Onthe Field Assistant navigation tree, select the control program that you want to import the data into.
2 Scroll to the bottom of the Properties page 1/0 Points tab, and then click Import.

3 Browse to the file you want to import.
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4 Click Continue. A side-by-side comparison of existing data and the new import data will appear. Red text
indicates one of the following errors:

Duplicate data—Existing data has duplicate I/0 numbers so that import cannot determine its match.
I/0 type mismatch—I/O Type in existing data does not match I/0 Type in import data.

Missing import data—Existing data has a point that import data does not have.

Missing system data—Import data has a point that existing data does not have.

5 Click OK to complete the import. Existing data that does not show an error will be overwritten by the imported
data.

Adjust airflow configuration for VAV or VVT controllers

To enter airflow parameters for a VAV Zone, VVT Zone or VVT Bypass controller, right-click on the controller in the
navigation tree and select Airflow Config in the menu.

For more information, see the following microblock details.
e VAV Zone - Airflow Control (page 94)

e VT Zone - PD Airflow Control (page 105)

e  VVT Bypass - BACnet Bypass Control (page 112)
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Graphics pages

Field Assistant can upload and display multiple graphics (.views) that were downloaded to a controller. But Field
Assistant can download only a single .view to the controller. If you edit one of the .views and download to the
controller, you will only download the edited .view. Information for the other .views will be removed from the
controller. You can reattach and redownload those .views from your system.

You can view and adjust your system from Graphics pages.

Some typical controls that may appear on a graphics page are:

Button or switch to turn equipment on or off

Input field to set a property value

Drop-down list to select a state

Interactive room sensor to override an unoccupied schedule
Setpoint graph to adjust setpoints

Trend graph to view trend information

Link to jump to another Field Assistant page

NOTES

Right-click a value, then select Details to view and change properties in the microblock pop-up.

Right-click a value, then select Global Modify to view and change the property in other control programs.

A yellow dashed line indicated a value that is forced or locked. ﬂ

If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane.
Select Scale to Fit again to return the graphic to its original size.

To attach a graphic in the Field Assistant interface

1 On the navigation tree, right-click the item that you want to attach a graphic to, then select Configure.
2 Equipment graphic only: If the system has other control programs of this type, select which control programs
you want to change.
@ Change this control program only.
Change for all control programs of this type on this network only.
Change for all control programs of this type.
NOTES
o If the control program is in an IP router, the second option will change the graphic for all control
programs of this type only on the IP network.
o If the control program is on the network below an IP router, the second option will not change the graphic
for the router's control programs of this type.
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3 Do one of the following:
If the graphic is...
In the Views Available list a. Select the graphic, then click Attach.
b. Click Accept.
Not in the Views Available list a. Click Add New.
b. Browse to select the view file.
c. Click Open.
d. Click Continue.
e. Click Close.
f. Click Close again.
NOTES

Select a graphic in the Attached list to edit the following information for the graphic:

o Display Name-The name that appears in the Graphics button drop-down list
e Category-The name of the category that multiple graphics may be sorted into in the Graphics button
drop-down list

NOTE Changes to Display Name or Category apply only in the Field Assistant interface and are not
retained if you export source files.

o Reference Name-The name that is used to create links to the graphic in ViewBuilder

o Default View-Sets the selected graphic as the default view if the tree item has multiple graphics. The
default graphic is bolded in the Attached list.
Included in download-Equipment graphics only. Select to have the .view file included in an All Content

download so that it can be uploaded by Field Assistant. The graphic will have E!f beside it in the
Attached list. Requires 4.x or later drivers.

You can click Delete Unused at the bottom of the Views section to delete all unattached graphic files from
your system.

To edit a graphic from the Field Assistant application in ViewBuilder

1 Inthe Field Assistant interface, double-click the controller in the navigation tree or right-click and select
Configure.

2  Select appropriate options.

3 Click Edit Existing button under Views.

4 Click Save and place the file in an appropriate folder.

5 Open ViewBuilder.

6  Select File > Open. Browse to your saved graphic and click to open.

7  Edit and save with a new name - the original system name is locked and cannot be used for an edited
graphic.
NOTE Names are case sensitive and should not have spaces and/or special characters.
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To control equipment using an interactive zone sensor

An equipment graphic may include an interactive zone sensor that provides you with the following control.

If the sensor is a... You can...

zS
e  Click & to raise the setpoint or ¥ to lower the setpoint.

e Click ) to override the schedule and put the zone in an occupied state.
To cancel an override, continue clicking & until the display shows 0.
- e  See that the zone is in an occupied state when the green LED is lit.
-]
O
OVR

SPT Standard, Plus, or Pro
o  Click the WARMER or COOLER button to adjust the setpoint.

e  Click the MANUAL button to override the schedule and put the zone in an
occupied state.
- e  Click the INFO button to cycle through the following information:
e T e  Qutside air temperature, if enabled in the control program
WP m:m e Override time remaining
s e  Heating setpoint

e  Cooling setpoint

e  See the Occupied/Unoccupied state in the display.

SPT Pro-Plus
e  Click the WARMER or COOLER button to adjust the setpoint.

e  Click the MANUAL button to override the schedule and put the zone in an
occupied state.

e  Click the INFO button to cycle through information such as:
e  Qutside air temperature
e Override time remaining

e  Heating setpoint

e  Cooling setpoint

Click the FAN button to adjust the fan speed.

Click the MODE button to perform customer-specific functions.

See the Occupied/Unoccupied state in the display.
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Copying properties from one controller to another

You can copy a control program's properties to other controllers that use the same control program. You do not
have to be physically connected to the controller that you are copying from. But, to download copied properties to
a controller, you must be connected to it or to the network that the controller resides on.

1

5

On the navigation tree, right-click the controller that has the properties you want to copy, then select Copy
Control Program Properties and click OK.

In the Global Copy dialog box, check Embedded Trend Graph Settings and All editable properties.

1. Select items to copy.
+| Embedded Trend Graph Seffings

J| All editable properties (except source links, BACnet object IDs, BAChet names, runtimes, and flow calibrations)

Click Search.
Do one of the following:

o  Check Skip bad values to copy all values except a bad value (the hardware differs, a property to be
copied is undefined, etc.).

o  Uncheck Skip bad values to prevent any values from being copied if a bad value is found.

Click Apply Changes, then close the dialog box.

NOTE If a message appears Copy process complete, but some values were not copied, click OK. Field Assistant
displays a list of parameters that were not copied.

Properties pages

Properties pages are automatically generated from control programs. Properties pages show the status of a piece
of equipment and the points/properties currently stored in it. See Checkout input and output, alarms, trends, and
network points (page 43) for details.

Use Properties pages to:

View the status of a piece of equipment. See Colors and status in the Field Assistant interface (page 16).
View or change the equipment point/properties currently stored in the controller.
Commission equipment (page 43)

Set up Linkage.

Refer to your individual controller's Installation and Start-up Guide for detailed explanations of the
points/properties.
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To view or edit properties on a Properties page

1 Select a controller on the navigation tree, click Properties, and then select the appropriate tab.
NOTE You must resolve any condition described in red text at the top of the page before a Properties page
can obtain current information from its controller.
2 Click ’ to show property details.
3 Do one of the following to change a property:
o  Select or clear a checkbox
o  Select an item on a drop-down list
o  Change text in a text field
4 Click Accept.
NOTES
e  Click the bold, underlined point name to open the editable microblock pop-up
e Right-click a value, then select Details to view and change properties in the microblock pop-up.
e Right-click a value, then select Global Modify to view and change the property in other control programs.
e Use Search/Replace on the Network Points tab to replace a term in the point address with another address.
. For the legend of status colors, see Colors and status in the Field Assistant interface (page 16).
e Avyellow dashed box around a value indicates the value is locked or forced.
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Changing properties/points in multiple controllers at the same time

Two Field Assistant features, Global Modify and Global Copy, allow you to view and change points or properties in
multiple controllers at the same time.

TIP Click to copy a reference path to the clipboard that you can use in ViewBuilder.

To use Global Modify

Use the Global Modify feature to:

View a microblock’s full path, control program name.
View or change a single property in several control programs at one time.

View errors on Graphics and Properties pages.

1 Browse to any page that displays the property you want to view or change.
2 Do one of the following to access Global Modify.
e Right-click the property, then select Global Modify.
e Alt+click the property.
3 Make changes to the Control Program field, if needed.
NOTES
o  Use wildcards in the Control Program field to broaden the search.
For example:
vav* matches vav, vavl, vavx, vavi2345
vav*z matches vavz, vavlz, vavxz, vavi2345z
vav*1*2 matches vavl2, vavabclxyz2
vav?? matches vava1, vav12, vavzz, but does not match vav, vavl, vavl23
* matches any control program
o  Click Show Advanced to view the location and value associated with this property.
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4  Select the tree item that you want to search under for every occurrence of that microblock in other control
programs.

5  Click Find All.
6  Select the properties in the list that you want to change.
7 Do one of the following:
a) Type a New Value a to the right of each selected item.

b) Select Enable All, type a new value in b, then click Set All To.
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c) Select Enable All, type a new value in c, then click Change All By.

8 Click Apply Changes.

NOTE To modify several properties in multiple control programs at the same time, use Global Copy.

To use Global Copy

Use Global Copy to copy any or all of the following from one control program to other equipment using the same
control program:

Embedded trend graph settings

Custom trend graphs

Custom reports

Other editable properties to other pieces of equipment using the same control program.

1 On the navigation tree, right-click the piece of equipment that has the properties you want to copy, then
select Copy Control Program Properties.

2 Click OK when you see This will copy this control programs properties to other control programs of the same
type. Continue?. This opens the next screen and does not lock in any changes.

In the Global Copy dialog box, select the items that you want to copy.

4  Select the area on the tree containing similar control programs that you may want to copy these properties to,
then click Search.

All instances at that level and below are listed in the expanded lower window.
Check or uncheck items as needed.
Do one of the following:

o  Check Skip bad values to copy all values except a bad value (it cannot be copied because you do not
have the necessary privilege, the property to be copied is undefined, etc.).

o Uncheck this field to prevent any values from being copied if a bad value is found.
7  Click Apply Changes, then close the Global Copy dialog box.
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Logic pages

The Logic page shows a custom control program for a programmable controller. The live data (yellow text) is
updated every few seconds and when you click the Logic button. The control program uses exact property values
for its calculations, but values are rounded to 2 decimal places when displayed on the Logic page.

_Q_TIP Click anywhere on the Logic page, then use your keyboard's Page Up, Page Down, and arrow keys to scroll
through the page.

NOTE If you find an unexpected value on a Properties page or a Logic page, you can use the Logic page to
troubleshoot.

To view a Logic page

1 Select a custom control program on the navigation tree.
2 Click Logic.

3 Click a microblock to view its details.

To locate a microblock, section, or label

1 Rightclick the Logic page, then select Jump To.
2 Do one of the following:
o On the Microblock or Section tab, select an item to have it located and highlighted.

o  On the Label tab, select a label to display a reduced logic page outlined in yellow that shows all
instances of the label. A red box indicates an output label; a yellow box indicates an input label. Click a
red or yellow box to jump to that label in the full-size logic page.

NOTE You can also click a label on the full-size logic page to display the reduced logic page.

To change properties, alarms, or trends

1 Click a microblock on the equipment’s Logic page.
2 In the microblock pop-up, click the Properties, Alarms, or Trends button.

3 Change properties, alarms, or trends for that microblock in the same way that you would make changes on a
regular Properties (page 54), Alarms (page 69), or Trends (page 65) page.

4 Click Accept.

NOTE Right-click a value, then select Global Modify to view and change the property in other control programs.
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Working with equipment in the interface

Using a Logic page to troubleshoot

The Field Assistant application monitors your system and provides feedback. If you get unexpected feedback, you
can use a Logic page as a troubleshooting tool. On the Logic page, work your way backward (right to left) through
the sequence in the control program to discover what caused the problem. See Microblock Reference (page 1) to
understand what each microblock in the sequence is doing.

Unexpected feedback Possible cause
Space temperature reads e The sensor has a short (or open) circuit. Verify wires are properly
excessively high or low connected at the sensor and controller.

e Asensor is missing or configured incorrectly. Open the sensor or input
microblock from the Logic page to verify its configuration.

Equipment displays an unexpected NOTE Equipment operates using effective setpoints. Open the Setpoint

color - effective setpoints are microblock from the Logic page and check the following:
different than the programmed .
setpoints e  Hysteresis

e Demand Level

e  Optimal Start

e Timed Local Override (TLO)
e  Setpoint Adjust

Gaps in trend data on trend graph Usually gaps result if network communication was disrupted or a point was
temporarily disabled.

If the gap is not the result of interrupted communication, send reports
more frequently. From the Logic page, open the trend microblock that
displayed the gap in data, then decrease the notification threshold so that
it is approximately 40% of the buffer size (allocated memory size) for that
microblock.

The Field Assistant application is Locate the microblock on the Logic page. If the color square on the
not receiving alarms from a BACnet microblock is black, the alarm is disabled. To enable it:

I icroblock
alarm microbloc 1 Click the microblock.

2 In the microblock pop-up, click the Alarms button.
3 Onthe Enable/Disable tab, select Potential alarm source.

The equipment is on when | expect  Use the Logic page to determine whether the program is sending an

it to be off, or off when | expectitto unexpected signal and why, or if the problem is with the physical

be on equipment. For example, the On-Off-Auto (OOA) switch on the controller for
that equipment may be locked in the On (Hand) position.

Sensor value on the Properties Calibrate the sensor.
page does not match the reading

from handheld sensor On the Logic page, check to see if the output point is locked on.
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To lock a BACnet point of value

You can lock certain editable parameters to a specified setting from the Properties page or microblock popup.
1 Select the Lock checkbox.

2 Type the value you want to send to the controller.

3 Click Accept.

NOTE Locked values are indicated by a dashed yellow line on graphics.

On Properties page > Control Program tab, click ’ to locate the point you wish to lock.

On the microblock popup:

1. Click on the underlined Name or Reference Name of the point on any of the Properties tabs to open the
microblock popup.

2. Click Properties page > Details tab to lock a value.
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Using schedules, trends, and reports

Creating and modifying a Field Assistant schedule

Using schedules, your equipment can maintain one set of setpoints during occupied periods to provide comfort,
and it can maintain a different set of setpoints during unoccupied periods to reduce energy consumption.
Schedules are the most effective cost-saving strategy.

NOTE Do not include preheating or precooling time in your schedules. Optimal Start (page 39), another cost-
saving strategy, automatically calculates and controls precise preheating and precooling routines.

& CAUTION Schedules are managed in the i-Vu® application and will override any that you set in Field
Assistant. You must use the i-Vu® application to set up Holiday schedules. You can use Field Assistant to set up
temporary schedules.

To view schedules

Select a controller on the navigation tree.
Click Schedules page > View tab.
Optional: Click an Effective bar to view all the schedules that contribute to the resulting schedule.

NOTE When multiple schedules affect a controller, Field Assistant sorts the schedules by priority—the higher
the priority, the closer the schedule is to the Effective bar. You set a schedule's priority when you add a
schedule.

To apply a schedule to a controller

Schedules in Field Assistant are typically based on zone occupancy.

1 On the navigation tree, select the controller you want to schedule.
2 Click the Schedules page > Configure tab.
3 Click Add.
4  Select a Priority. A schedule's priority determines whether affected zones will use occupied or unoccupied
setpoints.
Select... For...
Weekly A typical occupied period
Exception An unoccupied period that overrides a Weekly schedule
NOTE This functions the same as a Holiday schedule.
5 Select a Type. See table below.
6  Enter desired values in the fields below Description (50 characters maximum).
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7  Onthe graph, change a time segment's Start and End times by doing one of the following:
o  Click the segment, then type the times in the Start and End fields.
o  Click and drag either end of the segment or the entire segment.

8 Optional: Click Add Time Period to add one or more segments to the schedule. Or, select a segment and
click Delete Time Period to delete that segment.

9  Click Accept.

Type Schedule runs

Weekly Every week on the specified days

Date On a single, specified date

Date Range Between two specified dates

Date List On multiple, specified dates

Wildcard According to a repeating pattern (For example, the second Tuesday of every month)

Continuous Continuously between specified times on two separate dates

Dated Weekly Weekly between a start date and an end date (For example, the summer break in the school
year)

To edit or delete a schedule

Select the controller whose schedule was defined.
Click Schedules page > Configure tab.
Select the schedule you want to edit or delete.

Edit the fields you want to change or click Delete.

a b~ W N

Click Accept.
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Trends

Field Assistant can read and store equipment status values over a limited time and then displays this information
in a trend graph to help you monitor the equipment’s operation.

RTU Summary

— SATemp — RA Temp — MA Temp W Notes

You can collect trend data for any point value in the Field Assistant system. The controller reads point values at
intervals that you define and then stores that data in the controller. A controller has limited memory for storing
trend data.

After you set up the desired points for trend data collection (page 65), you can:

e View built-in trend graphs that show a single point (page 65)
e Create custom trend graphs with multiple points (page 66)

v

Enabled Points  ® | Cool Cap
Disabled Points » | Fan SIS —(—Single-point graphs
Custom trend graph — trend 1 r:::r:d::p
New Trend Graph... SAT
SPT
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To collect trend data for a point

Using schedules, trends, and reports

Before you can look at a trend graph for a point, you must enable trending for that point and then tell Field
Assistant how you want the equipment to collect the point's data.

1
2
3
4

5

On the navigation tree, select the controller that has the point you want to trend.

Click the Trends button drop-down arrow, select Disabled Points, then select the point.

Click the Enable/Disable tab, then check Enable Trend Log.
Enter information in the appropriate fields. See table below.
Click OK.

TIP You can set up all trends for a piece of equipment at once on the Trend Sources tab of the equipment's
Properties page.

Field Notes

Sample every _;_:_ (hh:mm)

Sample on COV
(change of value)

BACnet Conflguration

This method records (samples) the point’s value at the time
interval you define in this field.

NOTE Be sure to set trend intervals to one minute or greater.

This method records the point’s value only when the value
changes by at least the amount you enter in the COV Increment
field.

NOTE Use this method for a binary point or for an analog point
that has infrequent changes in value.

The Object Name is a unique alphanumeric string that defines the
BACnet object. Although the Object Name field can be edited, it is
not recommended. The Notification Class is set to 1 to receive

alarms generated by Carrier controllers.

Viewing a built-in, single-point trend graph

1
2
3

On the navigation tree, select the equipment whose trend you want to view.

Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to view.

Select the View tab. See Using trend graphs (page 68).

NOTE On the Configure tab, you can:

e Enable/disable the grid.
e  Set the time range for the X axis. For example, enter 7 days to see the data for the last week.
e Turn off autoscaling so that you can define a range for the Y-axis
e Type a Y-axis label that will appear on the right side of the graph.
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Creating a custom trend graph

When creating a custom trend graph, you can select up to 16 points. If you select more than 4 points or points
with different units, the Field Assistant application splits the data into subgraphs. Each subgraph can show a
maximum of 4 points with similar units.

Headqguarters Building - Rooftop Return Temps

= ATU=1 = ATU=Z =— RTU=

NOTE You must enable trending for points that you want to include in the custom trend graph. See To collect
trend data for a point (page 65).

To create a custom trend graph

1 On the navigation tree, select the area or equipment where you want to see the graph.
2  Click the Trends button drop-down arrow, then select New Trend Graph.
NOTE If the Trends button does not have a drop-down arrow, the New Trend Graph page is already displayed.

3 Inthe tree on the New Trend Graph page, use Ctrl+click or Shift+click to select the points (16 maximum) that
you want to see on a graph.

NOTE The tree shows only points that have trending enabled. See To collect trend data for a point (page 65).

4 Click Save.
5 Type a Name for the graph that will appear at the top of the graph and in the Trends button drop-down list.
6  Click OK.
7  Select:
o  The View tab to see the custom trend graph. See Using trend graphs (page 68).
o  The Configure tab to edit the trend graph. See To edit a custom trend graph (page 67).
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To edit a custom trend graph

On the navigation tree, select the area or equipment where you created the graph.

Select the Trends > Configure tab. On this page, you can:

Change the name of the custom trend graph

Enable/disable the grid

Set the time range for the X axis

Edit a subgraph's Y-axis label that will appear on the right side of the graph
Turn off autoscaling so that you can define a range for the Y-axis
Add/delete subgraphs (see instructions below)

Add/delete points (see instructions below)

Change a point's name on the graph

Change a binary point's active/inactive text on the graph

Click Delete Trend Graph to delete the entire custom trend graph

To add a subgraph to a custom trend graph

1
2
3
4

5
6

Click Add below the Subgraphs list.

Type a Y-axis label.

Click Add below the Points list.

Select a point in the Data source tree.

NOTE The tree shows only points that have trending enabled. See To collect trend data for a point (page 65).
Repeat steps 3 and 4 to add up to 4 points to the subgraph.

Click Accept.

NOTE To delete a subgraph, select it in the Subgraphs list, click Delete below the list, and then click Accept.

To add a point to a subgraph

1
2
3

4

Select the subgraph in the Subgraphs list.

Click Add below the Points list.

Select a point from the Data source tree.

NOTE The tree shows only points that have trending enabled. See To collect trend data for a point (page 65).

Click Accept.

NOTE To delete a point, select the appropriate subgraph, select the point, click Delete below the Points list, and
then click Accept.
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Using trend graphs
L O] «)

Chilled Water System - Chiller Load

b
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Click and drag will
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p Zoom

Hold shift to swap.
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Hover over a point for trend sample details. Press

space bar to lock details. Click+drag to move.

Ctrl+click to see details for the trend sample closest to

the cursor.

Touch mode: tap point for trend details. Touch and

hold point to lock details.
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e  Agray triangle at the top of a graph indicates a note from the system. Hover your cursor on the triangle to see
which of the following occurred:

o

Equipment received a time synchronization from its network router or from the Field Assistant
application.

Trend Historian has been enabled or disabled.
Trend Log has been enabled or disabled.

The trend object ID of a third-party trend source has been changed. For information only, you do not
need to do anything.

e Click @ at the top of the Field Assistant page to print the graph. You may need to set your printer's
orientation to Landscape.

e Toolbar options are also accessible by right-clicking a trend graph.

e You can check Display gap in graph line for missing data on an individual trend graph page.
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To view trend data in a spreadsheet program

You can save trend data as csv data that you can open in a spreadsheet program such as Microsoft® Excel®.

1 Onthe Trends > View tab, select @J > Save as CSV data.
2  Save the data (.zip file) wherever you want. The .zip file contains the following:
e A .csv file for each trend source (point). The filenames match the point names.
e A Combined folder containing a file with the combined data for all of the graph's trend sources.
3 Open the .csv file in a spreadsheet program.
NOTES

You will need to convert the data in the spreadsheet's Time column to a readable date/time format.
If you use Microsoft® Excel® on a Mac and the converted date shows the wrong year, do the following:
1. In Excel, go to File > Options > Advanced.

2. Scroll down to the section When calculating this workbook, and then uncheck Use 1904 date system.

To set up, edit, or disable a single alarm source

1 On the navigation tree, select the alarm source.

2  Select the Properties page and click on the specific point to open the microblock popup.

3 Click the Alarms tab in the popup.

4 Make changes to the fields as needed. See table below. The fields can vary for different types of alarm

sources.

5  Click Accept or Apply.

RS TIP To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm Sources.

Field Notes

Potential alarm source Select the checkbox to enable the alarm source to generate alarms. Clear the
checkbox to disable the alarm source.

Alarm Select to have the alarm source generate an alarm when the specified
conditions occur.
e  For a binary input, enter the conditions for generating an alarm.
e  For an analog input, type the low and high limits that, when exceeded, will

generate an alarm.

Deadband The amount inside the normal range by which an alarm condition
must return before a return-to-normal notification is generated.
NOTE If the Status checkbox is selected, the alarm condition currently exists.

Return to Normal Select to have the alarm source generate a return-to-normal when the alarm
condition returns to a normal state.
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Field

Fault

Alarm requires
acknowledgement

Return requires
acknowledgement

Classified as Critical

Notes

Select to have an alarm generated if the alarm source is not configured
correctly.

NOTE If the Status checkbox is selected, the alarm source is currently
misconfigured.

Select to have Field Assistant require that an operator acknowledge the alarm.

Select to have Field Assistant require that an operator acknowledge the return-
to-normal.

This property determines the color of the system-wide alarm button when the

alarm comes in.

n = Critical n = Non-critical

Event State The current state of the alarm source can be:
e  Normal—value is normal
e  Off normal—the value is not normal (binary only)
e  Fault—the alarm source microblock may be misconfigured
e High Limit—the value exceeds the normal range (analog only)
e Low Limit—the value is below the normal range (analog only)
BACnet N/A

Conflguration:

Dial on alarm

Notification Class Do not change this field.

Reports

Use Field Assistant reports to monitor and troubleshoot your system. See the table below for a list of all reports.

The Reports button drop-list varies depending on

Reports s . .
your navigation tree location and your connection.

Alarms -
Commissioning =
Equipment -

Locked Values
MNetwork 1O
Point List

This pre-configured report...

allows you to...

Alarms

Alarm Sources Create a summary of potential alarm sources (page 69).
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This pre-configured report...

Commissioning

Test & Balance

Equipment

Locked Values

Network 10

Point List

Network

Controller Status

Equipment Status

To run a report

Using schedules, trends, and reports

allows you to...

View the damper calibration parameters.

Find all locked points and locked values.

Verify the programming and status of all network points—especially useful for
commissioning controllers used for third-party integration.

View the details of all points. Verify that all points have been checked out
during commissioning. Also, create custom lists for other contractors. For
example, create a list of BACnet IDs or Web services links.

Discover network communication problems (shown as purple squares on the
report) that need troubleshooting. The report also shows boot and driver
version, download information, and if controller has 4.x or later driver, the
report shows the serial number and Local Access port status.

Display the thermographic color, status, and prime variable of each control
program.

1 Select an item on the navigation tree.

NOTE A report shows data for the selected tree item and all its children.

2  Click the Reports button drop-down arrow, then select a report.

3 Onthe Options tab, define the layout and content of the report.

NOTES

o  Changing the size and orientation of the printed page also changes the report layout on the View tab.

o To create a CSV (Comma Separated Values) file after you run the report, select Support CSV text format.
See To create a PDF, Excel spreadsheet, or CSV file (page 72).

o  The current operator's report options are saved so that when that operator logs in again, the same

options are used.
4 Click Run.

Click PDF if you want to print the report.
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To create a PDF, XLS, or CSV file

PREREQUISITE FOR CSV You must enable Support CSV text format on the Reports > Options tab before you run
the report.

1 Runareport.
2 Click PDF, XLS, or CSV.

3 For XLS or CSV, click Open to view the file or Save to save it.
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System Management

Although the Field Assistant application is a reliable front-end, you must perform periodic backups of the Field
Assistant database to ensure a quick recovery in case of failure. To make sure that your controllers have the latest
version of software you must install periodic library upgrades. The sections below describe how to backup and
restore the Field Assistant database and how to install the library updates.

To update Field Assistant

a b~ W N P

Go to the Field Assistant Launcher screen.

Click Help and select Update.

Browse to the .update file.

Check under Notes: for any pertinent information regarding the patch.

Click Apply and Restart Now, if necessary.

To update the equipment library

The Field Assistant application is equipped with a complete library. There are occasionally library (.sal file)
updates, which contain the following files:

graphic (.view)

control program (.equipment)
driver (.driver)

BACview (.bacview)

Touchscreen (.touch)

Notes:

Get the latest updates from your Carrier representative.

The library update only changes default graphics. If you have edited your graphic in ViewBuilder, it is not
updated.

Keep copies of the latest libraries in a safe place. In the event of a system restore, any updated .sal files
must be reapplied.

The last digits in the sal library name are the release date of the library.

Step 1: Upload new library to Field Assistant

1 Obtain the updated library (.sal file) from Carrier Control Systems Support.
2  Save the file to your computer in the iVu_Tools_x.x > sals folder.
3 Start your system in Field Assistant.
Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016

Help

All rights reserved
73




System Management

Follow these steps to implement the new equipment library:

Step 2: Update the files for the routers

1

2
3
4

Select the router that you wish to update in the navigation tree.
Right-click and select Driver Properties.
Select Properties page > Update tab.

If the database contains 2 or more routers, you must check Change for all control programs of this type in
the Controller section.

Click Update. A message appears Changes the driver and screen file to use the current library version.
Continue?

NOTE If more than one router exists, the additional routers are listed below the Update button.
Click OK.
Click Accept.

Step 3: Update the files for the controllers

1
2
3

Double-click the controller in the navigation tree or right-click and select Configure .
If you have multiple controllers of the same type, enable Change for all control programs of this type?.

Click Update under Controller. A message appears Changes the control program, view, driver and screen file
to use the current library version. Continue?

Click OK. When the message Updated to the library version xx. appears, click Close.
Repeat steps 1 - 4 for any additional types of controllers.

Click Close again.

Step 4: Apply the update to the controllers

1 Select the router in the navigation tree and then select the Devices > Manage tab.
2  Select controllers for download.
NOTE Use Ctrl+click, Shifttclick, or the Select All checkbox to select multiple controllers.
3 Select All Content and click Download.
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Advanced topics

Troubleshooting and communications

Troubleshooting a Local Access connection

Inability to communicate over a Local Access connection may cause the following symptoms:

Question marks on Field Assistant Properties pages and Graphics pages
Cannot obtain a Modstat from the connected controller

Controller Status report displays purple for a connected BACnet/IP controller
Cannot download to connected controller

A message says Local Access is disabled or unable to connect

No controllers found in Field Assistant

Possible cause Solution

BACnet/IP network number  Change the Field Assistant BACnet/IP network number to match the
in Field Assistant does not controller's IP network number.
match the number found in

the controller 1  Select the System E or router on the navigation tree to go to the

Devices page > Advanced tab.
2 Type new network number in BACnet/IP network.
3 Click Accept.

Selected COM portisin use  Shut down other applications such as PuTTY that may be running and holding

the port open.

Local Access is disabled Your manufacturer or representative must enable Local Access in the i-Vu®

interface.

Troubleshooting BACnet bindings

Every controller has a Device Binding Table that contains all Device IDs that the controller communicates with and
the network address of each device. This typically includes the Device ID of the BACnet Alarm Recipient.

If the Field Assistant application is not receiving alarms/trends or if the a point's value is incorrect, you can view
this table to see where the controller is looking for its data.

1 Onthe Field Assistant navigation tree, select the router that has incorrect or missing data.
2 On the Properties page, click Show Bindings.
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To change controller time settings using Field Assistant

To assign a controller as the Time Broadcaster

On a small, stand-alone network of controllers, the time in the controllers is synchronized with the controller that
you select as the Time Broadcaster.

On the navigation tree, select the System E

On the Devices page > Manage tab, click the Time Settings link.

Select the router or controller from the Time Broadcaster drop-down list.

A message appears for you to adjust the time intervals between broadcasts.

Click Accept.

a b W N

To adjust the Daylight Saving Time schedule

1 On the navigation tree, select the System E
2 Onthe Devices page > Manage tab, click the Daylight Saving link.

3 On the Daylight Saving tab, make changes as needed.
NOTE Click Update to automatically set the table's Begin and End dates for the next 10 years based on the
system's timezone. This marks all controllers for a Parameters download.

4 Click Accept.
5 Click OK.

If the updated dates are incorrect

If you clicked Update but the dates are incorrect, your system's Java timezone data may be out-of-date. Do the
following:

1 Goto the Oracle Java SE Download site (http;//java.sun.com/javase/downloads).
Download the JDK DST Timezone Update Tool (tzupdater-.zip).

In Field Assistant, go to the Devices page > Manage tab, click the Time Settings link.
On the Daylight Saving tab, click Import.

Browse to the tzupdater.zip file, select it, then click Open.

Click Continue.

Restart your system from the Field Assistant Launcher.

o N o o A~ W N

On the Daylight Saving tab, click Update.

Manual commands

To run a manual command in Field Assistant:
1 Press Ctrl+m to open the dialog box.

2  Type the manual command in the dialog box, then click OK.
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Command

bacnet showindex

bbmd commands:

bbmd read <IP address>

bbmd update <network
number>

bbmd view <network
number>

bbmd write <table file> <IP
address>

bbmd clear <IP address>

bbmd dump <network>
<file>

checkurls

checkurls -p

checkurls -v

commestat

copy

Field Assistant v6.5
Help

System Management

Description

Displays all files (file name, size, date) downloaded to the selected
controller.

Reads the BBMD table of the controller at the given IP address.

For example, to display the BBMD table in the BACnet device router at IP
address 154.16.12.101, type:
bbmd read 154.16.12.101

Selects BBMDs on the specified network and marks them for download. If
no network is entered at the end of the command, all networks in the
system are scanned.

For example, if the network number is 888, type:
bbmd update 888

Views the list of BBMDs that have been selected for the network number
at the end of the command. Assumes the update has been run.

For example:
bbmd view 888

Writes the BBMD table into the controller at the given IP address. See To
set up BBMDs through the Field Assistant interface.

For example, to write the BBMD table in dallasbbmd.bdt into the BACnet
device router at IP address 154.16.12.101, type:
bbmd write dallasbbmd.bdt 154.16.12.101

Clears the BBMD for the specified controller.

For example:
bbmd clear 154.16.12.101

Writes to a file the BBMD from the specified controller.

For example:
bbmd dump 888 dallasbbmd.bdt

1 Finds all network point exp: expressions for the selected item on the
navigation tree.

2  Converts the exp: expressions to bacnet:// equivalent expressions that
the controllers use.

3 Compares the equivalent bacnet:// expressions to the bacnet://
expressions currently downloaded in the controllers.

4 Displays any mismatches.

Does the same as checkurls, then adds any mismatches to the download
queue as parameter downloads.

Does the same as checkurls, but displays the exp: and bacnet://
expressions for all network points that were checked.

Gives a complete set of diagnostic information for all defined connections
as well as information regarding all modems in the system.

Displays a global copy utility that allows you to selectively copy trend
graphs, custom reports and all editable properties from the selected
equipment to other equipment in the system with the same control
program. See To use Global Copy (page 58).
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Command

download commands:

download m

download p
download s

g0 commands:

go <refname or path>

g0 ~network

go -logicpopup <refname>

go <device ID>/<object
ID>

go <object ID>

localhost

markdownload commands:

markdownload

markdownload p

markdownload s

memory

memory -free

modstat commands:

Description

Each of these commands performs an immediate download to a controller
for the selected control program, device, or driver.

Downloads all content, including parameters, schedules, and BBMDs (if
applicable).

Downloads parameters only.

Downloads schedules only.

Goes to the point in the system that is referenced.

For example:

go #oa_conditions
or

go vav_1/m28

Takes you to the network the selected object’s controller is associated to.

Goes to the microblock pop-up for the microblock that is referenced. You
must run this command from the microblock’s equipment on the
navigation tree.

For example:
go -logicpopup rs

Goes to a device and object on the navigation tree.

For example:
go 300550/A1:3

Goes to an object for the current device on the navigation tree.

For example, if a module alarm reports a control program Locked I/0
Alarm and references an error in program 11, click the link to go to the
device, then go to the object by typing:

go PRG:11

Shows the IP address of the Field Assistant web server

These commands place the controller for the selected tree item on the list
to download at a later time. The download list can be viewed at the System
level on the Downloads page.

Marks for an All Content download, that includes parameters, schedules,
and BBMDs (if applicable).

Marks for a Parameters download.

Marks for a Schedules download.

Shows the amount of server memory allocated for the Field Assistant
application and the amount being used.

Releases unused server memory, then shows the Field Assistant memory
usage before and after the release.

These commands display a Modstat (page 82) report.

NOTE It is not necessary to download a controller before running a Modstat
on it. Binding takes place when you run the modstat.
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modstat

modstat 8:<device instance
number>

modstat mac:<network
number>,<media type>:
<mac address>

paramupload

ping

rebuild

reload

restartmodule
revert

setdefault

Field Assistant v6.5
Help

System Management

Description

Displays status of the controller at the current location, including:
e  Hardware components of the device

e  Software components of the device

e Error conditions that may exist in the device

e Date and time the device is using

Displays status for a specific controller in the IP network using the
controller’s ID. Your location in the system does not have to be the
controller you are querying.

For example:
modstat 8:489202

Displays a Modstat for a specific controller in the system using the
controller’s MAC address. Network number is the number of the network
this controller is on; media type is the type of network the controller is on;
MAC address can be either the controller address or the IP address and
depends on the controller’'s media type.

Media types allowed are:
e bacnet/ip or b
e ms/tp orm
e ethernet or e

For example:
modstat mac:48161,arcnet:2
or
modstat mac:888,bacnet/ip: 172.16.101.119

Uploads parameters (editable properties) to the Field Assistant application
from the equipment or driver at the current location and below. If you want
to upload editable properties for all equipment under a particular router,
navigate to the router or the network on the navigation tree.

Ping to verify communication between IP devices. You cannot ping devices
on non-IP networks. To run this command type: ping <hostname>
where <hostname> is the IP address or device name.

For example:
ping 192.168.168.1
(will ping the IP address 4 times)

Rebuilds a Properties page. Use if you make changes to control program
property text in the Snap application.

Reloads a control program. Use if you make changes to control program in
the Snap application. Reloading updates all instances of the control
program throughout the system and marks the controller(s) for download.
The Field Assistant application determines the type of download based on
what changed in the control program.

Restarts the current controller.
Resets the selected driver or control program to its default values.

Sets the current page as the default view for the selected action button
and the selected tree location.
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Command

shutdown

storetrends

timesync

updatedriver commands:

updatedriver

whereami

zap

Using DEBUG MODE

Debug Mode saves considerable time when troubleshooting custom control programs for programmable
controllers. Typical operating mode in the Field Assistant application always downloads full source, which is time-
consuming. While operating in Debug Mode, full source is kept in the database and is not downloaded to the

controller.

Description

Shuts down the Field Assistant Server application. This stops
communication between the server and the client, but does not close any
open Field Assistant pages.

Uploads trend data from the controller(s) to the database for all equipment
at and below the selected item on the navigation tree. This command
stores trend data for points that have Trend Historian enabled.

Synchronizes the time on all controllers at the current location and below
to the time on the server. Run this command only from a location on the
navigation tree.

NOTE For CNN networks, executing a timesync on a controller sends the
timesync to its Gateway, and all the controllers under that Gateway.

Updates the selected controller to the latest version of its driver.

Displays the full path for the current location and gives the display and
reference names of the action button, category, instance and tab. If the
selected tree location differs from the location shown in the action pane
(for example, a point trend page), whereami returns information on both
locations.

Use this command when you create links in ViewBuilder.

Restarts the current controller.

& CAUTION Never leave your Field Assistant system without unchecking DEBUG MODE first and and then
downloading all content. The source files are not in the controller until you complete both steps.

To use DEBUG MODE

1 Select the custom control program in the navigation tree and either double-click it or right-click and select

Configure.

2 Check DEBUG MODE.

3 Download the new or edited control program. See Add or delete a custom control program (page 24) and
Change a control program or graphic.

4  Before logging out or switching to a different controller, select the control program in the navigation tree and
either double-click it or right-click and select Configure.

5 Uncheck DEBUG MODE.

6 Download All Content from the Downloads page, Devices page > Manage tab, or any page that has a

Download button.

Field Assistant v6.5
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Permissions Keys
When control programs, views, touchscreen, and BACview® files are created by an original equipment

manufacturer (OEM), they cannot be used in a Field Assistant system without the creator's permission. However,
the creator can produce a key for a system with a different license that will grant permission to the key's recipient.

If you receive a key, put it in a convenient location on your computer. You may want to keep it in the iVu_Tools_x.x
> resources > keys folder.

1 Inthe Field Assistant Launcher, click Help and select Permission Keys from the drop-down menu.

P
m Field Assistant Launcher l == ih]

Fielp)
r 1 Help Topics
System Name | sunshine_corp ~ + = PRop
) ' Permission Keys
Source Files [ Import | [ Export | Update
System Time Zone |USA - _(GM'I' -05:00) Eastern About
Communications

172.31.219.30 - Intel(R) 82579LM Gigabit Network Connection

@ |coma 2] If your port is not listed, relaunch this application
- with USE-L connected.

> B

System Status: Mot Started

License expires on 08/31/2015

e ———————————

2  To activate a key, click Add, browse to your key file and click Open.

3 To delete a key from your system, select the key in the table, then click Delete.

NOTE Red text in the table indicates the key has a problem such as it does not apply or has expired. See the
Notes column for an explanation.
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Using a Modstat to troubleshoot your system

A Modstat (Module Status) provides information about a controller and verifies proper network communication
with the controller.

To obtain a Modstat

You can get a controller's ModStat in the following places:
e Open controller—In the Field Assistant application

e XT controller—In the Field Assistant application or the controller's Local Access web pages

In the Field Assistant application
Use one of the following methods:
e Right-click a controller on the navigation tree, then select Module Status.

e  Select a controller on the navigation tree. On the Properties page, click Module Status.

In the controller's Local Access web pages (XT controller only)
1 Use an Ethernet cable to connect your computer to the controller's Local Access port.

2 Open a web browser on the computer. The Local Access web pages should automatically display showing the
Modstat.

NOTE To use Local Access, your web browser's Home page cannot be set to Google™.

Modstat field descriptions

NOTE Modstats vary for different types of controllers. The list below describes all information that could appear
on any Modstat. If a description differs between different generations of controllers, the generation is noted.

Field Description

Date/Time Date and time the Modstat was run

CM The controller's rotary switch address (MAC address)

Device Instance A unique ID assigned to the controller

Driver built When the driver was built

Downloaded by When and where the last download was performed

Application Software Version The name of the first control program that is downloaded

Flash Archive Status Shows the validity, date, and time of the most recent archive of

parameters and status to the controller's permanent flash memory.
The archive takes place once a day.

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
Help All rights reserved
82



Field

# PRGs initialized
# PRGs running

Firmware sections in flash
memory

Reset Counters:

Power failures
Brownouts

Commanded boots

System errors

Watchdog timeouts

S/W Watchdog
timeouts

H/W Watchdog

timeouts
System status
Network status

System error message history

Warning message history

Information message history

Manifest revision

Field Assistant v6.5
Help

System Management

Description

The number of control programs that were downloaded vs. the
number that are running. If these numbers are not the same, the
controller has a problem such as lack of memory.

The name, version, and date of the driver

Open controller: The number of times each of the following events
have occurred since the last time the controller was formatted.

XT controller: The number of times each of the following events have
occurred since the last time the controller was commanded to clear
the reset counters.

See NOTE below this table.

Interruption of incoming power
Low-level incoming power

Includes commands issued from the Field Assistant interface such as
the zap manual command, plus commands issued during a memory
download.

Error in the controller's firmware or hardware

Watchdog is firmware that monitors the firmware for normal
operation. If watchdog detects a problem, it restarts the firmware.

Watchdog is firmware that monitors the application firmware for
normal operation. If the watchdog firmware detects a problem, it
restarts the application firmware.

H/W Watchdog will restart the controller if it detects a severe problem
with the controller's operating system

Gives the current status of the controller's operation.
Gives the current status of the controller's networks.

Open controller: High-severity errors since the last memory download
or format. Shows the first 5 and last 5 messages.

XT controller: High-severity errors since the last memory download.
Shows the most recent 5 messages and oldest 5 messages.
See NOTE below this table.

Open controller: Low-severity errors and warning messages since the
last memory download or format. Shows the first 5 and last 5
messages.

XT controller: Low-severity errors and warning messages since the last
memory download. Shows the most recent 5 messages and oldest 5
messages.

See NOTE below this table.

Open controller: Information-only messages since the last memory
download or format. Shows the first 5 and last 5 messages.

XT controller: Information-only messages since the last memory
download. Shows the most recent 5 messages and oldest 5
messages.

See NOTE below this table.

Firmware revision
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Field Description

Installed bundles Components of the firmware

ARC156 reconfigurations during  An ARCNET network normally reconfigures itself when a controller is

the last hour added to or taken off the network. The Total field indicates the
number of reconfigurations in the last hour. Initiated by this node
indicates the number of reconfigurations caused by this controller,
the controller with the next lower rotary switch address, or any
controller located between these two controllers. An excessive
number in these fields indicates a problem with the network.

BACnet comm errors in the last 7 BACnet communication errors usually indicating dropped packets
days caused by high traffic on network.

Core (or Main) and Base board Gives the following information about the controller's boards:

hardware e Type and board numbers that are used internally by Carrier.

e The manufacture date and serial number.

e  Open controller only: The core board's RAM and Flash memory.
RAM is used for driver and control program executables.
Flash memory is used for firmware and file storage. See Flash
storage size below.

Largest free heap space Size of the largest piece of unused dynamic memory

Database size Open controller: Size of the controller's memory designated for
running programs. Database memory is used for control program
parameters, status and history; trends, schedules, and alarms; and
driver parameters, status and history.

XT controller: Size of the controller's memory.

Flash storage size The size of the flash memory that is not used by the firmware. This
memory is used for file storage and archiving.

Archive storage size The amount of flash memory remaining for archival after files are
downloaded.

File storage size The size of all files (control programs, graphics, driver, etc.)
downloaded to the controller. How much information is in these files
depends on whether the controller's Download All Content option is
selected in Field Assistant.

Raw physical switches The readings used to test the DIP or rotary switches

Network Information Open controller: The various network addresses for a controller
installed on an Ethernet. The Current and Assigned addresses will be
the same unless:

e The Assigned addresses were changed in PUuTTY.

e The controller's DHCP/Assigned DIP switch was moved to the
DHCP position after the Assigned addresses were defined.

e The Enable IP configuration changeover on the BACnhet Router
Properties page is being implemented.

XT controller: The various network addresses for the controller. The

Current and Assigned addresses will be the same unless the Enable

IP configuration changeover on the BACnet Router Properties page is

being implemented.

Route Information BACnet networks that a router is currently routing traffic to. The list
changes as BACnet routers are added or removed from the system.

Ethernet statistics Diagnostic counters directly related to the ethernet communications
hardware.
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NOTE XT controller only—If you want to clear the Reset counters and the three message history fields, click the
Clear Counts/Logs button on the controller's Properties page in the Field Assistant application or in the XT
controller's Local Access pages.
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Microblock reference

Microblock families

& The list below includes all microblock families, however, you may not see all of them. What information you
see depends on your license, the application you are using, or the control program type.

Family

Carrier (page 2)

/0 Pts (page 30)

Network /0 (page
120)

Display (page 167) &
Display2 (page 207)

Sys In (page 222)

Sys Out (page 251)

Log (page 267)

Control (page 283)

Convert (page 321)

Limit (page 352)

Relay (page 361)

Logic (page 378)

Math 1 (page 386)
Math 2 (page 399)

Description

Carrier microblocks allow the Field Assistant application to communicate directly with
CCN devices.

Input and Output Points microblocks communicate values between a control program
and a controller's physical inputs and outputs. Input values are read from sensors
connected to the controller's physical inputs. Output values are sent from the controller's
physical outputs to control components on the controlled equipment.

The Airflow and Zone Sensor microblocks belong to this family.

Network Input and Output microblocks pass information between points on the network.
A network input microblock reads the value of a network-visible BACnet® property on the
network or of an equivalent value from another supported protocol. A network output
microblock writes a value to a point on the network.

Display microblocks communicate directly with BACnet® objects, and can be used to
integrate BACnet devices into a Field Assistant system. They can be referenced on
graphics, allowing any vendor's BACnet equipment to be integrated into the system's
interface.

System Input microblocks receive heat and cool requests, as well as other system
information, editable properties, or constants used as input values to a control program.

System Output microblocks contain control program output values, such as heat and
cool requests or other status information. You can make these values network-visible to
other BACnet devices.

Log microblocks record system values, such as trends, alarms, and runtime values.

Control microblocks output signals that are used for control and scheduling purposes.
Many of these microblocks generate colors, which are used to communicate control
program or zone color status.

Convert microblocks take information from other microblocks, change the data in some
way, then output the changed data.

Limit microblocks test their input values against some limit, then output either the
original signal or the limit value.

Relay microblocks act as software relays to determine how and when an input signal
should be modified before it is sent from the microblock or the control program.

Logic microblocks perform logical operations on their inputs. Often these microblocks
determine the conditions that trigger equipment starts, stops, or alarms.

Math 1 microblocks perform simple mathematical operations on their inputs.

Math 2 microblocks perform advanced and trigonometric mathematical operations on
their inputs.




Misc (page 408) Miscellaneous microblocks include:

e DO/DI Proof

Up/Down Counter

Text

Version

Sunrise/Sunset

OCL (Operator's Control Language)

Carrier microblocks

The following Carrier microblocks allow the Field Assistant application to communicate directly with CCN devices.

m Carrier Controller (page 3)
A CCN Controller microblock does the following:

e  Establishes and verifies communication with a CCN device in the CCN network.

e  Contains the CCN device address so that all CCN points in the control program
can link to it.

e  Determines the refresh time for these related CCN points. Write points use
standard network microblocks that have individual refresh timers.

Carrier Binary Value (page 4)

The Carrier Binary Value microblock can monitor and force (restrict) a binary value in
a Carrier device.

cay Carrier Analog Value (page 7)

The Carrier Analog Value microblock can monitor and force (constrain or restrict) an
analog value in a Carrier device.

CEF Carrier Binary Point (page 9)

The Carrier Binary Point microblock reads the binary (on or off) value of a physical
input on the controller and makes this value available to be read by other BACnet
devices on the network. The value appears to other BACnet devices as the Present
Value property of a BACnet Binary Input Object.

CAF Carrier Analog Point (page 15)

The Carrier Analog Point microblock reads the analog (continuous) value of a physical
input on the controller. Then converts the raw data from the sensor to the
appropriate range for its unit of measurement (like mA, degrees Fahrenheit, or psi).

BACnet CCN Alarm (page 20)

The BACnet CCN Alarm microblock monitors CCN alarms and passes them from the
Carrier device to the Field Assistant Alarms page or third-party BACnet front end.

ExnM Carrier Schedule (page 22)
The Carrier Schedule microblock writes a weekly schedule to the CCN Controller.
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Zone Setpoint for Integration (page 26)

This microblock determines a zone's heating and cooling setpoints for both occupied
and unoccupied periods.

Carrier Text Display (page 28)

This microblock allows you to place descriptive text on the Properties page from a CCN
point.

CCN Controller

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol

What it does A CCN Controller microblock does the following:

Properties

Q TIPS
L]

Establishes and verifies communication with a CCN device in the CCN network.

Contains the CCN device address so that all CCN points in the control program
can link to it.

Determines the refresh time for these related CCN points. Write points use
standard network microblocks that have individual refresh timers.

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.

Limitations:

lower case only

limited to 40 characters

cannot begin with a number

must be unique within a control program

Name The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.



Refresh Time

Bus
Element

Editing Privilege

Show Property Page Text

Comm error limit

Refresh controller Info

Simulation

The interval at which all CCN points in the program read their target values from the
CCN device.

The number of the CCN network. (0-239)
A unique number assigned to each device on a CCN network (1-239).

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.
Check to show this microblock's value on the equipment's Propertles page.

The number of communication failures to allow before a CCN device is considered
offline and the microblock's COMM output goes OFF.

Select to initiate a read of the CCN device so that device information such as model
number, serial number, etc. can be obtained.

Define the value(s) the microblock will use when you simulate the control program.

Carrier Binary Value

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family

Icon and symbol

What it does

Field Assistant v6.5

Help

Carrier microblocks (page 2)

CEY point name

The Carrier Binary Value microblock can monitor and force (restrict) a binary value in
a Carrier device.

A Carrier Binary Value microblock:

e Is not visible to the network

e Does not contain a BACnet object

e Cannot be an alarm source

e Cannot be trended

See the Carrier Binary Point microblock if you need these features.

This microblock's poll rate is set in the related CCN Device microblock.
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Properties

Q TIPS
[ ]

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.

Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

L[]

must be unique within a control program

Com Enabled Check to enable network communications for this microblock. Uncheck when
troubleshooting.

Name The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.



Path

Default Value

Actlve Text
Inactlve Text

Editable

Editing Privilege

Show Property Page Text

Field Assistant v6.5
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Use the information below to format a valid path for the microblock you are using to
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric
characters. Check Editable if you want the path to be editable in the Field Assistant
interface.

Path format:
CCN://LINK/<table name>/<point name><:instance#><@force level>

LINK represents the CCN device defined in the CCN Controller microblock.

<table name> - Use one of the following;:

Definition table name:Data table name
Example: CCN://LINK/MYTABLE:MYDATAL

Definition table name:lnstance number
Example: CCN://LINK/MYTABLE:1

Data table name
Example: CCN://LINK/MYDATAL

Where:

e Definition table name is the name of the POC table that describes the data
structure of the child tables.

e  Data table name is the name of the table instance that contains the variable or
field being referenced.

e Instance# is the table instance number

<point name>
Example: CCN://LINK/. . ./HEATSP

<:instance#> (Optional) - Use the instance number of the point name if the table has
more than one point with the same name.

<@force level> (Optional) - The force level being written to (a value 1-15)
Example: CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4

You can edit the address/path of a CCN point in one of the following places in the
Field Assistant interface:

e The Detalls tab of a Point Properties dialog box
e The Address column on the Propertles > Network Polnts page

The value that the microblock outputs when communication with all specified targets
fails or when Communications Enabled is not checked. The default value is used
when the Valid? output is False (Off).

The Active Text your system displays when the microblock's output is on, or true.
The Inactive Text your system displays when the microblock's output is off, or false.

Check to make this microblock's value editable in the Field Assistant interface.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.
Check to show this microblock's value on the equipment's Propertles page.
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Simulation

Define the value(s) the microblock will use when you simulate the control program.

Carrier Analog Value

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)
Icon and symbol CAY point name

What it does The Carrier Analog Value microblock can monitor and force (constrain or restrict) an
analog value in a Carrier device.

A Carrier Analog Value microblock:

e |s not visible to the network

e Does not contain a BACnet object

e Cannot be an alarm source

e  Cannot be trended

See the Carrier Analog Point microblock if you need these features.

This microblock's refresh rate is set in the related Carrier Device microblock.

Properties

Q TIPS
e Alttclick any value in the interface to view property details, including its editing privilege and expression

(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.

Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Comm Enabled Check to enable network communications for this microblock. Uncheck when
troubleshooting.



Display resolution

Name

Path

Field Assistant v6.5
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The microblock's value is truncated and incrementally updated as follows:

The Display resolution format is used to truncate the microblock’s actual value. For
example, if you enter a value from:

e 0.1to0 0.9, the system displays 1 digit to the right of the decimal
0.01 to 0.99, the system displays 2 digits to the right of the decimal
e 1 or greater, the system displays a whole number
The Display resolution value determines the increment by which the displayed value
is updated. For example, if you enter:

e .2 the system displays 8.4, 8.6, 8.8, ...
e .03, the system displays 5.09, 5.12, 5.15, ...
10, the system displays 30, 40, 50, ...

The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.

Use the information below to format a valid path for the microblock you are using to
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric
characters. Check Editable if you want the path to be editable in the Field Assistant
interface.

Path format:
CCN://LINK/<table name>/<point name><:instance#><@force level>

LINK represents the CCN device defined in the CCN Controller microblock.

<table name> - Use one of the following;:

Definition table name:Data table name
Example: CCN://LINK/MYTABLE:MYDATAL

Definition table name:lnstance number
Example: CCN://LINK/MYTABLE:1

Data table name
Example: CCN://LINK/MYDATAL

Where:

e Definition table name is the name of the POC table that describes the data
structure of the child tables.

e  Data table name is the name of the table instance that contains the variable or
field being referenced.

e Instance# is the table instance number

<point name>
Example: CCN://LINK/ . ../HEATSP

<:instance#> (Optional) - Use the instance number of the point name if the table has
more than one point with the same name.

<@force level> (Optional) - The force level being written to (a value 1-15)
Example: CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4

You can edit the address/path of a CCN point in one of the following places in the
Field Assistant interface:

e The Detalls tab of a Point Properties dialog box
e  The Address column on the Propertles > Network Polnts page

Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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Default Value

Editable

Editing Privilege

Show Property Page Text

Simulation

The value that the microblock outputs when communication with all specified targets
fails or when Communications Enabled is not checked. The default value is used
when the Valid? output is False (Off).

Check to make this microblock's value editable in the Field Assistant interface.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Check to show this microblock's value on the equipment's Propertles page.

Define the value(s) the microblock will use when you simulate the control program.

Carrier Binary Point

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family

Icon and symbol

What it does

Carrier microblocks (page 2)

CEF CEBF point name

The Carrier Binary Point microblock:

e  Can monitor and force (constrain or restrict) a variable in a Carrier device
e s visible to the BACnet network

e  Contains a BACnet binary value object

e  Contains a BACnet trend log object

e Can be an alarm source

e (Can be trended

o Uses the out-of-service BACnet requirements

e Can be used in a graphic to force a variable

This microblock's refresh rate is set in the related Carrier Device microblock.

The Carrier Binary Point microblock reads the binary (on or off) value of a physical
input on the controller and makes this value available to be read by other BACnet
devices on the network. The value appears to other BACnet devices as the Present
Value property of a BACnet Binary Input Object. You can assign a name to each input,
which appears on the face of the microblock and is used as the name of the BACnet
object.



Properties

Q TIPS
[ ]

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Com Enabled Check to enable network communications for this microblock. Uncheck when
troubleshooting.

Writable Check to allow BACnet commands to write to present value.

Force Level The force level being written to (1-15).

Name The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.

Description (optional) A BACnet-visible microblock description.

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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Path

Default Value

Actlve Text
Inactlve Text

Editable

Editing Privilege

Show Property Page Text

Use the information below to format a valid path for the microblock you are using to
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric
characters. Check Editable if you want the path to be editable in the Field Assistant
interface.

Path format:
CCN://LINK/<table name>/<point name><:instance#><@force level>

LINK represents the CCN device defined in the CCN Controller microblock.

<table name> - Use one of the following;:

Definition table name:Data table name
Example: CCN://LINK/MYTABLE:MYDATAL

Definition table name:lnstance number
Example: CCN://LINK/MYTABLE:1

Data table name
Example: CCN://LINK/MYDATAL

Where:

e Definition table name is the name of the POC table that describes the data
structure of the child tables.

e  Data table name is the name of the table instance that contains the variable or
field being referenced.

e Instance# is the table instance number

<point name>
Example: CCN://LINK/. . ./HEATSP

<:instance#> (Optional) - Use the instance number of the point name if the table has
more than one point with the same name.

<@force level> (Optional) - The force level being written to (a value 1-15)
Example: CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4

You can edit the address/path of a CCN point in one of the following places in the
Field Assistant interface:

e The Detalls tab of a Point Properties dialog box
e The Address column on the Propertles > Network Polnts page

The value that the microblock outputs when communication with all specified targets
fails or when Communications Enabled is not checked. The default value is used
when the Valid? output is False (Off).

The Active Text your system displays when the microblock's output is on, or true.
The Inactive Text your system displays when the microblock's output is off, or false.
Check to make this microblock's value editable in the Field Assistant interface.
Preset - Each microblock property has an appropriate privilege or role assigned to it.

You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Check to show this microblock's value on the equipment's Properties page.



BACnet Configuration

Network Visible Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Object ID Auto-assign - A BACnet Object ID is assigned by the system.
Use specific value - (0-3999999) Assign a number that is unique within the
controller.

History

Change of State Time The date and time the most recent change of state occurred.

Change of State Count The number of times the point has changed states. Click Reset to set Change of
State Count to O.

Time of State Count Reset  The date and time the change of state count was set to zero.

Elapsed Active Time The amount of time the point has been in the "on" state. Click Reset to set Elapsed
Actlve Time to O.

Time of Active Time Reset  The date and time the elapsed active time was set to zero.

Trends

Enable Trend Log Check to have the controller collect trend data for the microblock's present value.

Sample every ___ Records the microblock's present value at this interval.

(hh:mm:ss) .
EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.
NOTE Set this field in Snap to one minute or greater. After the control program is
running in a live system, if needed you can adjust this setting in the live system based
on the characteristics of the CCN bus and its polling interval. See "To collect trend
data for a point" in i-Vu help, or see the CCN Integration Guide.

Sample on COV Records the microblock’s present value only when the value changes.

(change of Value)

Max samples The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

Click Reset on the Properties page in a system to delete all samples currently stored
in the controller.

Field Assistant v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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Alarm

Enable Trend Historian

Keep historical trends for
__days

Write to historian:

Every ___ trend samples

Use default (45% of Max
samples)

Ina system only:

Stop When Full

Enable trend log at specific
times only?

Store Trends Now

Trend samples
accumulated since last
notification

Last Record Wrltten to
Historlan

Delete

BACnet Configuration

Potentlal alarm source

Critical

Category

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.

The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical & = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.



Template

Alarm Enabled?

Alarm State

Delay Seconds

Return Enabled
Fault Enabled
Alarm requires
acknowledge

Return requires
acknowledge

Alarm text

Return text

BACnet Configuration

Dlal on alarm

Notification Class

Simulation

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Check to send a message when this microblock indicates an alarm condition.

Select the checkbox to have an alarm condition exist when the microblock's present
value is on (true).

Clear the checkbox to have an alarm condition exist when the microblock's present
value is off (false).

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

Check to send a message when an alarm condition has returned to normal.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > View tab.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Select to have this alarm immediately delivered through a modem connection.

Defines how alarm notifications shall be prioritized in their handling according to TO-
OFFNORMAL, TO-FAULT, and TO-NORMAL alarms; whether these categories of alarms
require acknowledgement (nearly always by a human operator); and what destination
devices or processes should receive notifications.

Define the value(s) the microblock will use when you simulate the control program.

Field Assistant v6.5
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Carrier Analog Point

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol cor MCAF  point name

What it does The Carrier Analog Point microblock:
e  Can monitor and force (constrain or restrict) a variable in a Carrier device
e Isvisible to the BACnet network
e  Contains a BACnet analog value object
e  Contains a BACnet trend log object
e Can be an alarm source
e (Can be trended
e Uses the out-of-service BACnet requirements
e Can be used in a graphic to force a variable
This microblock's poll rate is set in the related Carrier Device microblock.

The Carrier Analog Point microblock reads the analog (continuous) value of a physical
input on the controller. Then converts the raw data from the sensor to the
appropriate range for its unit of measurement (like mA, degrees Fahrenheit, or psi).

Properties

:QiTIPS
L]

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.

Limitations:

lower case only

limited to 40 characters

cannot begin with a number

must be unique within a control program

Com Enabled Check to enable network communications for this microblock. Uncheck when
troubleshooting,.

Writable Check to allow BACnet commands to write to present value.

Force Level The force level being written to (1-15).



Display resolution

Name

Description

Path

Field Assistant v6.5
Help

The microblock's value is truncated and incrementally updated as follows:

The Display resolution format is used to truncate the microblock’s actual value. For
example, if you enter a value from:

e 0.1t0 0.9, the system displays 1 digit to the right of the decimal

e 0.01t00.99, the system displays 2 digits to the right of the decimal

e 1 or greater, the system displays a whole number

The Display resolution value determines the increment by which the displayed value
is updated. For example, if you enter:

e .2 the system displays 8.4, 8.6, 8.8, ...

e .03, the system displays 5.09, 5.12, 5.15, ...

e 10, the system displays 30, 40, 50, ...

The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.

(optional) A BACnet-visible microblock description.

Use the information below to format a valid path for the microblock you are using to
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric
characters. Check Editable if you want the path to be editable in the Field Assistant
interface.

Path format:
CCN://LINK/<table name>/<point name><:instance#><@force level>

LINK represents the CCN device defined in the CCN Controller microblock.

<table name> - Use one of the following:

Definition table name:Data table name
Example: CCN://LINK/MYTABLE:MYDATA1

Definition table name:Instance number
Example: CCN://LINK/MYTABLE:1

Data table name
Example: CCN://LINK/MYDATAL

Where:

e Definition table name is the name of the POC table that describes the data
structure of the child tables.

e Data table name is the name of the table instance that contains the variable or
field being referenced.

e Instance# is the table instance number

<point name>
Example: CCN://LINK/. . ./HEATSP

<:instance#> (Optional) - Use the instance number of the point name if the table has
more than one point with the same name.

<@force level> (Optional) - The force level being written to (a value 1-15)
Example: CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4

You can edit the address/path of a CCN point in one of the following places in the
Field Assistant interface:

e  The Details tab of a Point Properties dialog box
e  The Address column on the Properties > Network Points page

Carrier Proprietary and Confidential CARRIER CORPORATION ©2016
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Trends

Default Value

Editable
Show Property Page Text

Editing Privilege

BACnet Configuration

Network Visible

Object ID

COV Increment

Enable Trend Log

Sample every ___
(hh:mm:ss)

Sample on COV
(change of value)

Max samples

The value that the microblock outputs when communication with all specified targets
fails or when Communications Enabled is not checked. The default value is used
when the Valid? output is False (Off).

Check to make this microblock's value editable in the Field Assistant interface.
Check to show this microblock's value on the equipment's Propertles page.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the
controller.

An Analog Network Input (ANI) that references this microblock in its Address field
tries to subscribe to this microblock's COV (Change of Value) service. If subscription
succeeds, the ANI receives a value from this microblock only when this microblock's
present value changes by at least the COV Increment. If subscription fails, the ANI
reads this microblock's value at intervals specified in the ANI's Refresh Time field.

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

NOTE Set this field in Snap to one minute or greater. After the control program is
running in a live system, if needed you can adjust this setting in the live system based
on the characteristics of the CCN bus and its polling interval. See "To collect trend
data for a point" in i-Vu help, or see the CCN Integration Guide.

Records the microblock’s present value only when the value changes by at least the
COV Increment.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

NOTE Click Reset on the Properties page in a system to delete all samples currently
stored in the controller.



Enable Trend Historian

Keep historical trends for
__days

Write to historian:
Every ___ trend samples

Use default (45% of Max
samples)

Ina system only:

Stop When Full

Enable trend log at specific
times only

Store Trends Now

Trend samples

accumulated since last
notification

Last Record Wrltten to
Historian

Delete

BACnet Configuration

Alarm

Potentlal alarm source

Critical

Category

Template

Field Assistant v6.5
Help

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.

The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical & = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.
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Low Limit Enable

Low Limit

High Limit Enable

High Limit

Dead Band

Delay Seconds

Return Enabled

Fault Enabled

Alarm requires
acknowledge

Return requires
acknowledge

Alarm text

Return text

Simulation

Check to send an alarm when the microblock's present value remains below the Low
Limit value for the defined Delay Seconds.

The value the microblock's present value must drop below to send an alarm.

Check to send an alarm when the microblock's present value remains above the High
Limit for the defined Delay Seconds.

The value the microblock's present value must rise above to send an alarm.

The amount inside the normal range by which an alarm condition must return before
a return-to-normal notification is generated.

EXAMPLE

High=225—pﬁ.7f—\-nvm_n sband
215 - = Leagban
- T 10 = Deadband

Low = -25 = Leadban

= Alamn is generated
& Return-to-Mormal is generated

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

Check to send a message when an alarm condition has returned to normal.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > Vlew tab.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Define the value(s) the microblock will use when you simulate the control program.



BACnet CCN Alarm

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol ALARM

CALARM active

What it does The BACnet CCN Alarm microblock monitors CCN alarms and passes them from the
Carrier device to the Field Assistant Alarms page or third-party BACnet front end.

The Alarm ID string is used to match an incoming CCN alarm to this microblock. In
most cases, this is the CCN variable name. This microblock monitors all CCN alarms,
and sends an alarm event to the Field Assistant application when a CCN alarm is
received that matches the Alarm ID.

Also, you can define a BACnet CCN Alarm microblock with Accept all Alarms checked to
act as a catchall for alarms that do not match other Alarm microblock match strings.
When the Field Assistant application receives an alarm, it searches all BACnet CCN
Alarm microblocks for matching Alarm ID's. If no match is found the alarm is
processed by the BACnet CCN Alarm microblock that has Accept all Alarms checked.

Two alarms will be generated: one from the BACnet CCN Alarm microblock that
includes the original CCN alarm text, and another from the related "Point" microblock
because the Present_Value (updated via the received alarm message) may trigger an
alarm intrinsic to the AV or BV object in the "Point" microblock. If this behavior is
undesirable, the Event_Enable flags in the corresponding "Point" microblock should
be set to FALSE to inhibit the intrinsic alarm from the "Point" microblock.

This microblock will have a digital output wire that transitions to “on” when the alarm
is active. If Accept all Alarms is checked - then the output will toggle on then go back
off. RTN messages are posted as a separate event. If that is desired another
microblock with the “specific” text should be added. Then, the output will stay active
until an RTN of that type of alarm is received.

The parameters for this microblock will be similar to the alarm parameters in any
Carrier microblock that can be an alarm source, and the user will be able to enable
and disable this alarm. When disabled, the microblock will still reflect the alarm
status of the CCN device that sourced the alarm, but an event will not be sent to the
Field Assistant application.

Properties

:g: TIPS

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.
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Alarm

Reference Name
RefName

Network Visible

Name

Description

Controller

Alarm ID

Actlve/Inactlve Text

Editing Privilege

Object ID

Accept All Alarms

Potential alarm source

Critical

Use the default reference name unless you want a more descriptive name for
graphics or network links.

Limitations:

e  |ower case only

e limited to 40 characters

e  cannot begin with a number
L[]

must be unique within a control program
Check to make the microblock's output visible to third-party equipment.

The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.

NOTE To use this field, the device's driver must be equal to or greater then 3.04.xxx.
You cannot edit this field during run time.

Use the text portion of the CCN alarm message generated by the Carrier PIC device.
Enter the following text match=""T051%x""

TO51%x respresents the CCN alarm code generated by the CCN equipment. See
Carrier's Controls and Troubleshooting Guide for specific alarm codes.

Do not change this path from the default CCN://LINK. If altered, the alarms will not
be forwarded.

A variable name/point name of the Carrier CCN point you wish to monitor for an
alarm.

The Field Assistant interface displays the Active Text when an alarm occurs, and the
Inactive Text when the alarm status is normal.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the
controller.

Acts as a catchall for alarms that do not match pre-defined Alarm ID strings. When an
alarm arrives, it will first search all BACnet CCN Alarm microblocks for matching Alarm
ID's, if no match is found, the alarm will be processed by the BACnet CCN Alarm
microblock with Accept all Alarms.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical & = Non-critical



Category

Template

Alarm Enabled?

Alarm State

Return Enable
Fault Enable
Alarm requires
acknowledge

Return requires
acknowledge

Alarm text

Return text

Simulation

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Check to send a message when this microblock indicates an alarm condition.

Select the checkbox to have an alarm condition exist when the microblock's present
value is on (true).

Clear the checkbox to have an alarm condition exist when the microblock's present
value is off (false).

Check to send a message when an alarm condition has returned to normal.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > Vlew tab.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Define the value(s) the microblock will use when you simulate the control program.

Carrier Schedule

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol
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What it does The Carrier Schedule microblock writes a weekly schedule to the CCN Controller.

The Carrier Schedule microblock provides the CCN controller with an occupancy
schedule. The CCN occupancy schedule is generated from a BACnet schedule
originating in the Field Assistant application or a BACnet BMS. The CCN controller
must use the same occupancy SCHEDULE NUMBER as this microblock's Write to
global schedule number. property (default=1). This ensures the schedule from this
microblock is written to the correct schedule in the CCN controller.

The Schedule Number range is 1-99.

The Carrier Schedule microblock can write to the local schedule (schedule # 1 - 64)
of a CCN controller or to a controller configured to receive a CCN Global schedule
(schedule # 65 - 99). It will not write a schedule to a CCN controller that is
broadcasting a global schedule.

The microblock has three outputs:

e  The first (top) outputs On or Off to indicate the occupancy state of the microblock.
The second outputs how much time remains in the current state.

The third outputs On or Off to indicate if an override is in effect. This output could
be used to feed a trend microblock.

Properties

:gi TIPS

e Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Display Name The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.
Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Description (optional) A BACnet-visible microblock description.

Editing Privilege Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Schedule Category The category of the schedule that will run the controlled equipment. Select
Occupancy unless you have defined a custom schedule category in the Snap and
Field Assistant applications.

Schedule number e 1 - 64 are local schedules that reside within the equipment.

e 65 - 99 are network or global schedules, which are sent over a CCN network and
received by controllers that contain network schedules.



Group schedule
overrides?

Configuration

Active Text

Inactive Text

Minimum off time
Minimum on time

Timed override minutes

Second press cancels
override

CCN Schedule Number

Show scheduling limits:

Weekly  Schedules -
Max Transitions Per
Day

Max Exceptlon
Schedules

Max Transltlons

Allows an override from a single controller to override all controllers within it's Group
number.

The Active Text your system displays when the microblock's output is on, or true.

The Inactive Text your system displays when the microblock's output is off, or false.

The minimum period (seconds) that the microblock's present value will be off,
regardless of the input signal to the microblock.

The minimum period (seconds) that the microblock's present value will be on,
regardless of the input signal to the microblock.

Minutes the microblock adds to the zone's occupied time for each press of the zone's
local override button or switch.

Select to have a second press of a zone sensor's override button cancel the override.
If not selected, a second press will increase the override by the amount of time
defined in the Timed override minutes field.

The CCN device must be configured for a schedule number between 1 and 99
inclusive.

The default limits for the Occupancy schedule category.
NOTES
e Aschedule download will fail if you exceed these limits when creating schedules.

e Changing these properties erases the schedule information in the controller,
requiring you to download schedules again.

e If you use Global Modify to change these limits, the affected devices will not be
automatically marked for schedule download.

The number of transitions a weekly schedule allows in a 24-hour period. The default
is 6, which creates 5 schedule segments.
The number of non-weekly schedules allowed in a controller. The default is 30. The

system reserves 7 of these schedules - one for each day of the week.

The number of transitions a non-weekly schedule allows in a 24-hour period. The

Per Day default is 6, which creates 5 schedule segments.

Property Page Text

Show Property Page Text Check to show this microblock's value on the equipment's Properties page.

Property Page Text You can edit the microblock description that appears on the Propertles page. See
"Editing Properties page text using special characters" and "Formatting a microblock
property" in Snap Help.

BACnet Configuration

Network Vislble Check to allow other BACnet equipment to read or change the microblock's present

value.
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Object Instance

Potential alarm source

Critical

Category

Template

Alarm

Alarm Enable

Delay Seconds

Alarm text

Alarm requires
acknowledge

Return to Normal

Return Enabled

Return text

Return requires
acknowledge

Fault
Fault Enabled

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the controller.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical & = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide alarm
button when the alarm comes in.

Check to send a message when this microblock indicates an alarm condition.

The time the microblock's present value must remain in an alarm condition before the
microblock sends an alarm.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > View tab.

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.



Simulation

Define the value(s) the microblock will use when you simulate the control program.

Zone Setpoint for Integration

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol

What it does This microblock determines a zone's heating and cooling setpoints for both occupied
and unoccupied periods.

You can determine a zone's setpoints for both occupied and unoccupied periods;
however, because of factors such as local overrides, demand level, or optimal start
routines, the zone's effective setpoints may be calculated differently by the

microblock.
NOTE The Zone Setpoint for Integration microblock is only supported in the UPC
Open.
Inputs and outputs

Input

occ Binary input - indicates whether or not the zone is currently occupied

ZONE Analog input - current zone temperature

HT Analog input - Effective heating setpoint from the linkage provider

CL Analog input - Effective cooling setpoint from the linkage provider

Output

co Analog output - preset cooling occupied setpoint

cu Analog output - preset cooling unoccupied setpoint

HO Analog output - preset heating occupied setpoint

HU Analog output - preset heating unoccupied setpoint
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Properties

:g: TIPS

e Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only to
determine that property's functionality in your system.

Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.

Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Setpoints

Color Change Hysteresis The Color Change Hysteresis is represented by the Hyst setting on the Properties page.
When returning to normal, it is the number of degrees required to exceed the setpoint
before the microblock's color changes. An appropriate hysteresis prevents equipment
from "chattering" when the temperature is very close to and oscillating around the
setpoint.

The desired occupied and unoccupied zone setpoints (degrees) and the value of each
occupied color band (degrees).

A color band's value determines the threshold at which the microblock changes the
zone thermographic color as the zone temperature departs from setpoint.

You can use the free cooling light green color band to enable economizer operation. If
you are not using this feature, type O for this band's value.

EXAMPLE

e
2
o
=]
(5]
(5]
]
=
-

Occupied

Light blue
Cark blue




Editing Privilege Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Show Property Page Text Check to show this microblock's value on the equipment's Propertles page.

Carrier Text Display

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family Carrier microblocks (page 2)

Icon and symbol

What it does This microblock allows you to place descriptive text on the Properties page from a CCN
point.
Properties
Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Name The microblock label used in the interface. You can use any characters (including
spaces) in this field, except for the " character.
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Path

Communications Enabled

Editing Privilege

Show Property Page Text

Use the information below to format a valid path for the microblock you are using to
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric
characters. Check Editable if you want the path to be editable in the Field Assistant
interface.

Path format:
CCN://LINK/<table name>/<point name><:instance#><@force level>

LINK represents the CCN device defined in the CCN Controller microblock.

<table name> - Use one of the following;:

Definition table name:Data table name
Example: CCN://LINK/MYTABLE:MYDATAL

Definition table name:lnstance number
Example: CCN://LINK/MYTABLE:1

Data table name
Example: CCN://LINK/MYDATAL

Where:

e Definition table name is the name of the POC table that describes the data
structure of the child tables.

e  Data table name is the name of the table instance that contains the variable or
field being referenced.

e Instance# is the table instance number

<point name>
Example: CCN://LINK/. . ./HEATSP

<:instance#> (Optional) - Use the instance number of the point name if the table has
more than one point with the same name.

<@force level> (Optional) - The force level being written to (a value 1-15)
Example: CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4

You can edit the address/path of a CCN point in one of the following places in the
Field Assistant interface:

e The Detalls tab of a Point Properties dialog box
e The Address column on the Propertles > Network Polnts page

Check to enable network communications for this microblock. Uncheck when
troubleshooting.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Check to show this microblock's value on the equipment's Propertles page.



Microblock reference

Input and Output Points microblocks

Input and Output Points microblocks communicate values between a control program and a controller's physical
inputs and outputs. Input values are read from sensors connected to the controller's physical inputs. Output
values are sent from the controller's physical outputs to control components on the controlled equipment.

The Airflow and Zone Sensor microblocks belong to this family.

HIl

BACnet Analog Input (page 31)

Reads the analog (continuous) value of a physical input on the controller. Converts the raw data
from the sensor to the appropriate range for its unit of measurement (such as mA, degrees
Fahrenheit, or psi).

BACnet Binary Input (page 37)
Reads the binary (on or off) value of a physical input on the controller.
Timed Local Override (page 42)

Reads a local override input signal from a user-adjustable switch or button in the zone. Converts the
signal, then outputs a remaining time value.

Pulse to Analog Input (page 48)

Counts pulses from a binary (on or off) input over a specified period of time. Every minute,
calculates and outputs the average number of pulses received over the specified time.

BACnet Analog Output (page 53)

Sends an analog (continuous) value from the control program to a physical analog output on the
controller.

BACnet Binary Output (page 59)

Sends a binary (on or off) value from the control program to a physical digital (on or off) output on
the controller.

Floating Motor (page 63)

Works with a bi-directional motor actuator triggered by two digital signals, such as clockwise and
counterclockwise or damper open and damper closed. Converts a percent open value from the
control program to on and off signals to two physical digital outputs on the controller.

Pulse-Width Output (page 69)

Converts a percent value from the control program to a digital on or off signal that varies in duration
based on minimum and maximum values you define.

Zone (Airflow and Sensors)

Field Assistant v6.5
Help

U Line Airflow Control (page 76)

This microblock cannot be used for Carrier controllers.

LogiStat Zone Sensor (page 76)

This microblock cannot be used for Carrier controllers.
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Microblock reference

RS Zone Sensor (page 76)

Sends information to and receives values from a variety of sensor configurations. Works with a
schedule and setpoint microblock to maintain zone temperature at setpoint.

RS Zone Sensor with Fan Control (page 84)

Sends information to and receives values from a variety of sensor configurations. Works with a
schedule and setpoint microblock to maintain zone temperature at setpoint. Enables the sensor's
fan control and mode functionality.

Airflow Control (page 94)

Maintains VAV zone airflow at setpoint. Its inputs, outputs, and properties interface with a
controller's built-in airflow control algorithm. The algorithm ensures that zone airflow stays above the
specified minimum for zone indoor air quality standards.

Enables VAV testing and balancing through your system interface or through the stand-alone Airflow
Test and Balance Utility.

BACnet Pressure Dependent Control (page 105)

Calculates and maintains the desired damper position in a pressure dependent zone. Controls AUX
reheat operation and fan operation in a fan powered box.

Its inputs, outputs, and properties interface with the control algorithms built into other controllers.
The algorithm ensures that zone airflow stays above the specified minimum for zone indoor air
quality standards.

Enables testing and balancing through the Field Assistant interface or through a stand-alone utility.
Controls the damper and other key zone operations, such as the fan (FAN) and auxiliary heat (AUX
HEAT), during commissioning.

BACnet Bypass Control (page 112)

Controls the bypass damper based on the commanded position input wire. Converts the pressure
sensor count to pressure and output this value to the DUCT SP wire. Allows for the configuration of
the duct static pressure setpoint and the maximum static pressure setpoint during LAT override.

Enables testing and balancing through the Field Assistant interface. Calibrates the airflow sensor
readings at design setpoint and zero calibration of sensor when AHU fan is off. Calibrates full open

and closed damper positions.

BACnet Analog Input

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family /0 Point microblocks (page 30)

Icon and symbol point name

What it does Reads the analog (continuous) value of a physical input on the controller. Converts

Field Assistant v6.5
Help

the raw data from the sensor to the appropriate range for its unit of measurement
(such as mA, degrees Fahrenheit, or psi).
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Microblock reference

How it works

The Input Type, Sensor Type, Scaling Range (linear sensor types only) and Input Resolution together determine
how the microblock converts raw sensor data into the microblock's output value.

For non-linear sensor types, you can set up a custom translation table that has sensor input values (kOhms or
volts) and their equivalent output values. You set up these tables in your system on a driver's Custom Translation
Tables Propertles page.

Linear sensor types use the slope-intercept formula for a line (y=mx+b).

EXAMPLE For a 0-20 mA input type using a Linear w/offset scaling method (4-20 mA) and a scaling range of 20
to 420 gpm, a sensor reading of 8 mA produces a microblock output value of 120 gpm.

y =gpm

420 —
|
|
|
|
|
|
|
|
|
|
|

120 — 420 gpm - 20 gpm 5 gpm

T 20mA-4mA T mA
|
|
20 @ - ——————— — — —
X =mA
I I I
4 8 20
-80 —¢" b (y-intercept)
calculated by control module

y=mx+b

gpm
y=25——|(8 mA |- 80 gpm = 120 gpm
mA

The Input Resolution determines the final microblock output. The driver rounds the microblock's present value
according to the resolution and prevents it from fluctuating too rapidly.

EXAMPLE If the calculated present value is 13.789 and you set the Resolution to 0.1, the control program uses
13.8 for any calculations downstream from the microblock. The output remains at 13.8 until the calculated
present value rises to 13.9 or falls to 13.7.

Limitations

Inputs are limited to a controller's supported input types. See the controller's documentation for more information.
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Microblock reference

Configuration example

For a 4-20 mA flow meter designed for operation between 20 and 420 gpm that is wired to input 3 on a
controller's expander 4:

Units gpm S

Hardware Configuration

Expander 4

[nput Mumber 3

[nput Ty pe 0-20 ma, w
Calibration

Input Resolution 1

Sensor Type (Scaling Method) | Linear wi offset, 4-20 ma |+

Scaling Range
hAifirruem 20
hARXITILIT 420

NOTE An input resolution of 1 causes the microblock to output gpm in whole numbers.

See the controller's documentation for more information on assigning inputs and outputs to points.

Properties

:g: TIPS
L]

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only
to determine that property's functionality in your system.

Display Name The microblock label used in the Snap application and the Field Assistant interface.
You can use any characters except the " character.
Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e |ower case only

limited to 40 characters

cannot begin with a number

e must be unique within a control program

Description (optional) A BACnet-visible microblock description.

Lock Present Value Check to output the locked value from the microblock instead of the microblock's
calculated value.
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Microblock reference

Editing Privilege

Units

Hardware Configuration

Expander

Input Number

Input Type

Calibration

Input Resolution

Sensor Type
(Scaling Method)

Scaling Range
Minimum

Scaling Range
Maximum

BACnet Configuration

Network Visible

Field Assistant v6.5

Help

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

The unit of measurement of the microblock's present value. Select from the BACnet
engineering units in this droplist. For some microblocks, you can customize the
droplist by selecting Options > Preferences > Droplist Options.

The address of the expander (1 to 6) that has the physical input this microblock
reads. Type O for a physical input on a controller without an expander.

The number of the physical input the microblock reads.
The type of equipment wired to the input number that the microblock reads.

Universal Input - Provides backwards compatibility with drivers earlier than
v2.02.022. With later versions, this selection displays a ? value in the system.

The increment by which the microblock updates the value on its output wire in a
system.

The Resolution format is used to truncate the microblock’s actual value. For example,
if you enter a value from:

e 0.1to0 0.9, the wire displays 1 digit to the right of the decimal

e 0.011t00.99, the wire displays 2 digits to the right of the decimal

e 1 orgreater, the wire displays a whole number

The Resolution value determines the increment by which the present value is
updated. For example, if you enter:

e .2 the wire displays 8.4, 8.6, 8.8, ...

e .03, the wire displays 5.09, 5.12, 5.15, ...

e 10, the wire displays 30, 40, 50, ...

The scaling method the controller uses to convert the raw sensor data to the
appropriate range for the input's engineering units.

Applies to linear Sensor Types only. The value associated with the minimum sensor
signal to the controller's physical input.

EXAMPLE For a 4-20 mA sensor that reads from 20 to 420 gpm, type 20 so that
when the input reads 4 mA, the microblock outputs a value of 20.

Applies to linear Sensor Types only. The value associated with the maximum sensor
signal to the controller's physical input.

EXAMPLE For a 4-20 mA sensor that reads from 20 to 420 gpm, type 420 so that
when the input reads 20 mA, the microblock outputs a value of 420.

Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.
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Object Instance

COV Increment

Show Property Page
Text

Alarms

Potential alarm source

Critical

Category

Template

Alarm

Low Limit Enable

Low Limit

High Limit Enable

High Limit

Dead Band

Field Assistant v6.5
Help

Microblock reference

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the
controller.

An Analog Network Input (ANI) that references this microblock in its Address field
tries to subscribe to this microblock's COV (Change of Value) service. If subscription
succeeds, the ANI receives a value from this microblock only when this microblock's
present value changes by at least the COV Increment. If subscription fails, the ANI
reads this microblock's value at intervals specified in the ANI's Refresh Time field.

Check to show this microblock's value on the equipment's Propertles page.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical é\q = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Check to send an alarm when the microblock's present value remains below the Low
Limit value for the defined Delay Seconds.

The value the microblock's present value must drop below to send an alarm.

Check to send an alarm when the microblock's present value remains above the High
Limit for the defined Delay Seconds.

The value the microblock's present value must rise above to send an alarm.

The amount inside the normal range by which an alarm condition must return before
a return-to-normal notification is generated.

EXAMPLE
High = 225 —p’;\y&—nw—m Deadhand
315 - = Deadban
= 1 10 = Deadband
Low = -25 = Jeadban
= Alam is generated
# Return-to-Mormal is generated
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Microblock reference

Trends

Delay Seconds

Alarm text

Alarm requires
acknowledge

Return to Normal
Return Enabled

Return text

Return requires
acknowledge

Fault
Fault Enabled

Enable Trend Log

Sample every __
(hh:mm:ss)

Sample on COV
(change of value)

Max samples

Field Assistant v6.5

Help

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > View tab.

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

Records the microblock’s present value only when the value changes by at least the
COV Increment.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

NOTE Click Reset on the Properties page in a system to delete all samples currently
stored in the controller.
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Enable Trend Historian

Keep historical trends for
__days

Write to historian:
Every ___ trend samples

Use default (45% of Max
samples)

Ina system only:

Stop When Full

Enable trend log at specific
times only

Store Trends Now

Trend samples
accumulated since last
notification

Last Record Wrlitten to
Historian

Delete

BACnet Configuration

Simulation

Microblock reference

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.

The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Define the value(s) the microblock will use when you simulate the control program.

BACnet Binary Input

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family
Icon and symbol

What it does

Field Assistant v6.5
Help

/0 Point microblocks (page 30)

BL BI  point name

Reads the binary (on or off) value of a physical input on the controller.
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Microblock reference

How it works

The Input Type, Active Text, Inactive Text, and Polarity together determine how the microblock converts raw
sensor data into the microblock's output value.

The Input Type tells the microblock whether to expect a sensor that closes and opens an unpowered set of

contacts to produce an on or off signal (dry contact) or a sensor that provides an on or off electrical signal up to
10 Vdc (binary input).

Then, based on the signal and Polarity, the microblock converts the sensor's signal to a true or false value and
displays the Active Text or Inactive Text.

Polarity Signal Output
Normal on (true) Active Text
off (false) Inactive Text
Limitations

Inputs are limited to a controller's supported input types. See the controller's documentation for more information.

Configuration example

For a normally closed status relay indicating whether a fan is on or off wired to input 3 on a controller's expander
4:

Hardware Configuration

Expander 4

Input Kumhber 3

Input Type Dy Contact W

System Setup

Inactive Text Off

Active Text on

Fuolarity reversed w
Properties

Q TIPS
[ ]

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only
to determine that property's functionality in your system.

Field Assistant v6.5
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Microblock reference

Display Name The microblock label used in the Snap application and the Field Assistant interface.
You can use any characters except the " character.
Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e  |ower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

Description (optional) A BACnet-visible microblock description.

Lock Present Value Check to output the locked value from the microblock instead of the microblock's
calculated value.

Hardware Configuration

Expander The address of the expander (1 to 6) that has the physical input this microblock
reads. Type O for a physical input on a controller without an expander.

Input Number The number of the physical input the microblock reads.

Input Type The type of equipment wired to the input number that the microblock reads.

Use the following guidelines for choosing the Input Type:

e Binary Input - Configures the microblock to read a set of contacts which
close/open for an on/off signal.

NOTE We recommend using Binary Input.
e  Dry Contact - Same as Binary Input.
e H-O-A Status Feedback - Reads status of HOA switches.
Do not use:
e  Universal Input - Not supported.
e  Pneumatic Input - Not supported.
e Special - Reserved for Carrier Engineering Dept.

e  Counter Input - Not supported. Use the Pulse to Analog Input microblock

instead.
System Setup
Inactive Text The Inactive Text your system displays when the microblock's output is off, or false.
Active Text The Active Text your system displays when the microblock's output is on, or true.
Polarity Normal - The microblock's output is on when the signal to the microblock is on, and
is off when the signal to the microblock is off.
reversed - The microblock's output value is off when the signal to the microblock is
on, and is on when the signal to the microblock is off.
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Microblock reference

BACnet Configuration

Network Visible

Object ID

Show Property Page Text

Alarms

Potential alarm source

Critical

Category

Template

Alarm

Alarm Enabled?

Alarm State

Delay Seconds

Alarm text

Alarm requires
acknowledge

Return to Normal
Return Enabled

Return text

Return requires
acknowledge

Field Assistant v6.5
Help

Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the
controller.

Check to show this microblock's value on the equipment's Properties page.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical é\q = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Check to send a message when this microblock indicates an alarm condition.

Active - An alarm condition exists when the microblock's present value is on (true).
Inactive - An alarm condition exists when the microblock's present value is off (false).

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > Vlew tab.

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > Vlew tab.
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Fault
Fault Enabled

Trends

Enable Trend Log

Sample every ___
(hh:mm:ss)

Sample on COV
(change of Value)

Max samples

Enable Trend Historian

Keep historical trends for
—days

Write to historian:
Every ___ trend samples

Use default (45% of Max
samples)

Ina system only:

Stop When Full

Field Assistant v6.5
Help

Microblock reference

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

Records the microblock’s present value only when the value changes.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

Click Reset on the Properties page in a system to delete all samples currently stored
in the controller.

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.
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Microblock reference

Enable trend log at specific
times only?

Store Trends Now

Trend samples
accumulated since last
notification

Last Record Written to
Historlan

Delete

BACnet Configuration

Simulation

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.

The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Define the value(s) the microblock will use when you simulate the control program.

Timed Local Override

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family
Icon and symbol

What it does

How it works

/0 Point microblocks (page 30)

tla L. point hame
Reads a local override input signal from a user-adjustable switch or button in the
zone. Converts the signal, then outputs a remaining time value.

This value can be used by a time clock microblock (page 283) to indicate a change in
occupancy status.

Each time the user presses the button or switch that is assigned to this input, the input senses a binary signal.
The microblock converts this binary input signal, or pulse, into a time output (minutes) using one of 3 methods

you choose and set up.

Method

Pulse Input

Field Assistant v6.5

Help

Description
Pulses counted x Each pulse = Present Value
Present Value accumulates up to Maximum Value.

You can define a reset signal for the user in the Cancel override if input closed for >
____seconds field.
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Fixed Width Input Pulse sensed x Each pulse = Present Value

No accumulation with multiple pulses.

No reset signal.

Microblock reference

Mechanical Input Override enabled by a constant-signal device such as a wind-up timer.

Signal sensed x Input closed = Present Value

Limitations

Maximum Value cannot exceed 546 minutes.

Configuration example

Override Type and Setup
) Pulse Input

Each pulse

Cancel owerride if input closed for =

) techanical Input
Input Closed | 90
Input Open = 0:00

) Fixed \Width Input
Each pulse | 90
Mo Accumulation

hdaximum W alue 490.0
Resolutian 0.1
Properties

:g: TIPS

minutes
seconds

minutes

minutes

minutes

Alt+click any value in the interface to view property details, including its editing privilege and expression

(location path) for use on graphics.

You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only
to determine that property's functionality in your system.

Field Assistant v6.5

Help

Carrier Proprietary and Confidential

CARRIER CORPORATION ©2016

All rights reserved



Microblock reference

Display Name The microblock label used in the Snap application and the Field Assistant interface.
You can use any characters except the " character.
Reference Name Use the default reference name unless you want a more descriptive name for
RefName graphics or network links.
Limitations:

e lower case only

e limited to 40 characters

e cannot begin with a number

. must be unique within a control program

Description (optional) A BACnet-visible microblock description.

Lock Present Value Check to output the locked value from the microblock instead of the microblock's
calculated value.

Editing Privilege Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Units The unit of measurement of the microblock's present value. Select from the BACnet
engineering units in this droplist. For some microblocks, you can customize the
droplist by selecting Options > Preferences > Droplist Options.

Hardware Configuration

Expander The address of the expander (1 to 6) that has the physical input this microblock
reads. Type O for a physical input on a controller without an expander.

Input Number The number of the physical input the microblock reads.

Input Type The type of equipment wired to the input number that the microblock reads.

Universal Input - Provides backwards compatibility with drivers earlier than
v2.02.022. With later versions, this selection displays a ? value in the system.

Override Type and Setup
Pulse Input, Select the method the microblock uses to convert the controller's binary input signal
Mechanical Input, into a time value (minutes). See "How it works" in this microblock's help.

or Fixed Width Input
Each pulse Minutes the microblock adds to the zone's occupied time for each press of the zone's
local override button or switch.

Cancel override if input  Seconds the user must press the local override button to cancel timed local override
closed for > __seconds and return the zone to the unoccupied mode.

Input Closed Minutes the microblock adds to the zone's occupied time for each press of the zone's
local override button or switch.

Maximum Value Maximum value (up to 546 minutes) the microblock outputs regardless of additional
pulses from the controller's input.
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Microblock reference

Resolution The increment by which the microblock updates the value on its output wire in a
system.

The Resolution format is used to truncate the microblock’s actual value. For example,
if you enter a value from:

e 0.1to0 0.9, the wire displays 1 digit to the right of the decimal

e 0.011t00.99, the wire displays 2 digits to the right of the decimal

e 1 or greater, the wire displays a whole number

The Resolution value determines the increment by which the present value is
updated. For example, if you enter:

. .2, the wire displays 8.4, 8.6, 8.8, ...

e .03, the wire displays 5.09, 5.12, 5.15, ...

e 10, the wire displays 30, 40, 50, ...

BACnet Configuration

Network Visible Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Object Instance Auto-assign - A BACnet Object ID is assigned by the system.
Use specific value - (0-3999999) Assign a number that is unique within the
controller.

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field

tries to subscribe to this microblock's COV (Change of Value) service. If subscription
succeeds, the ANI receives a value from this microblock only when this microblock's
present value changes by at least the COV Increment. If subscription fails, the ANI
reads this microblock's value at intervals specified in the ANI's Refresh Time field.

Out Of Service Minimum  If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True

Pres Value and then he writes a value lower than this value to the microblock's Present_Value,
Minimum Value the controller returns a Property, Value_Out_Of_Range error.
Show Property Page Check to show this microblock's value on the equipment's Propertles page.
Text
Alarms

Potential alarm source Check to make this microblock available in the system's Alarm Sources list.

Critical Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical é\q = Non-critical

Category The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Template Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.
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Microblock reference

Alarm

Low Limit Enable

Low Limit

High Limit Enable

High Limit

Dead Band

Delay Seconds

Alarm text

Alarm requires
acknowledge

Return to Normal

Return Enabled

Return text

Return requires
acknowledge

Fault
Fault Enabled

Field Assistant v6.5
Help

Check to send an alarm when the microblock's present value remains below the Low
Limit value for the defined Delay Seconds.

The value the microblock's present value must drop below to send an alarm.

Check to send an alarm when the microblock's present value remains above the High
Limit for the defined Delay Seconds.

The value the microblock's present value must rise above to send an alarm.

The amount inside the normal range by which an alarm condition must return before
a return-to-normal notification is generated.

EXAMPLE

High = 225%1&-0 sband
215 - = Leadban
= 1 10 = Deadband

Low = -25 = Headhan

= Alam is generated
# Return-to-Mormal is generated

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > View tab.

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > Vlew tab.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.
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Trends

Enable Trend Log

Sample every ___
(hh:mm:ss)

Sample on COV
(change of value)

Max samples

Enable Trend Historian

Keep historical trends for
—days

Write to historian:
Every ___ trend samples

Use default (45% of Max
samples)

Ina system only:

Stop When Full

Enable trend log at specific
times only

Store Trends Now

Trend samples
accumulated since last
notification

Last Record Wrlitten to
Historlan

Delete

Field Assistant v6.5
Help

Microblock reference

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

Records the microblock’s present value only when the value changes by at least the
COV Increment.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

NOTE Click Reset on the Properties page in a system to delete all samples currently
stored in the controller.

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.
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Microblock reference

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Simulation

Define the value(s) the microblock will use when you simulate the control program.

Pulse to Analog Input

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family /0 Point microblocks (page 30)
Icon and symbol MM+ point name

What it does Counts pulses from a binary (on or off) input over a specified period of time. Every
minute, calculates and outputs the average number of pulses received over the
specified time.

How it works

Many meters measure flow rates and output pulses, where each pulse represents a quantity of the flowing
medium. For example, a pulse might equal a quantity of water (gallons/pulse), gas (cubic feet/pulse), or electricity
(kWh/pulse). Your meter determines your Gain, or the quantity that each pulse represents. For example, a flow
meter that measures 15 gallons/pulse has a Gain of 15. This microblock calculates and outputs the flow rate
from the pulses using the following formula:

{Pulses counted during Pulse Window)

Fleww rate {output) = Pulse Window

¥ Gain

EXAMPLE

During a Pulse Window of 30 minutes the microblock counts 90 pulses. Each pulse represents 15 gallons (Gain =
15). The microblock calculates and outputs a flow rate of 45 gallons/minute.

gallons
minute

I |
50 pulses <15 gallons _

30 minytes pulse 45

Flow rate {output) =

Limitations

Some controllers do not support pulse counting or do not support pulse counting on all inputs. Most controllers
that support pulse counting cannot count more than 4 pulses per second. See the controller's documentation for
more information.
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Configuration and programming example

Microblock reference

For an electric meter connected to input 3 on a controller's expander 1 that reads 10 kWh/pulse:

kblh Pu

LInits

Hardware Configuration

Expander 1

Input Mumber K]

Input Type Counter Input

Calibration

Gain 10.0

FPulse Window 20

Resolution 0.1
Properties

:g: TIPS

1002

W

DEHAHD

If the microblock counts 50 pulses over 30
minukes, its autput is:

50 pulses x 10 kWwh
30 minutes pulse

Demand is usually measured in kW, so the
control program mdltiplies the Pulse to Analog
Input microblock’s output by 60 o convert the
cutpul to kKW,

16.67 kWwh x50 Minutes

= 1002 kWw
minute hour

e  Alt+click any value in the interface to view property details, including its editing privilege and expression

(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only
to determine that property's functionality in your system.

Display Name

The microblock label used in the Snap application and the Field Assistant interface.

You can use any characters except the " character.

Reference Name
RefName

Limitations:

Description

Lock Present Value

Field Assistant v6.5
Help

lower case only

limited to 40 characters

cannot begin with a number

must be unique within a control program

(optional) A BACnet-visible microblock description.

Carrier Proprietary and Confidential

Use the default reference name unless you want a more descriptive name for
graphics or network links.

Check to output the locked value from the microblock instead of the microblock's
calculated value.
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Microblock reference

Editing Privilege Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Units The unit of measurement of the microblock's present value. Select from the BACnet
engineering units in this droplist. For some microblocks, you can customize the
droplist by selecting Options > Preferences > Droplist Options.

Hardware Configuration

Expander The address of the expander (1 to 6) that has the physical input this microblock
reads. Type O for a physical input on a controller without an expander.

Input Number The number of the physical input the microblock reads.

Input Type Select Counter Input.

Calibration

Gain The quantity that each meter pulse represents.

EXAMPLE For a flow meter that measures 15 gallons/pulse, type 15.

Pulse Window The period (minutes) over which the microblock averages the flow rate. The
microblock uses a sliding window.

Resolution The increment by which the microblock updates the value on its output wire in a
system.

The Resolution format is used to truncate the microblock’s actual value. For example,
if you enter a value from:

e 0.1to0 0.9, the wire displays 1 digit to the right of the decimal

e 0.01t00.99, the wire displays 2 digits to the right of the decimal

. 1 or greater, the wire displays a whole number

The Resolution value determines the increment by which the present value is
updated. For example, if you enter:

e .2, the wire displays 8.4, 8.6, 8.8, ...

e .03, the wire displays 5.09, 5.12, 5.15, ...

e 10, the wire displays 30, 40, 50, ...

BACnet Configuration

Network Visible Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Object Instance Auto-assignh - A BACnet Object ID is assigned by the system.
Use specific value - (0-3999999) Assign a number that is unique within the
controller.

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field

tries to subscribe to this microblock's COV (Change of Value) service. If subscription
succeeds, the ANI receives a value from this microblock only when this microblock's
present value changes by at least the COV Increment. If subscription fails, the ANI
reads this microblock's value at intervals specified in the ANI's Refresh Time field.

Out Of Service Minimum  If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True

Pres Value and then he writes a value lower than this value to the microblock's Present_Value,
Minimum Value the controller returns a Property, Value_Out_Of_Range error.
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Microblock reference

Out Of Service If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True,
Max Pres Value and then he writes a value higher than this value to the microblock's Present_Value,
Maximum Value the controller returns a Property, Value_Out_Of_Range error.

Show Property Page Check to show this microblock's value on the equipment's Propertles page.

Text

Alarms

Potential alarm source Check to make this microblock available in the system's Alarm Sources list.

Critical Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical é\q = Non-critical

Category The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Template Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Alarm

Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low
Limit value for the defined Delay Seconds.

Low Limit The value the microblock's present value must drop below to send an alarm.

High Limit Enable Check to send an alarm when the microblock's present value remains above the High
Limit for the defined Delay Seconds.

High Limit The value the microblock's present value must rise above to send an alarm.

Dead Band The amount inside the normal range by which an alarm condition must return before
a return-to-normal notification is generated.

EXAMPLE
High = 225 —pﬁa&—ﬂvm Deadband
15 - = Deadban
= 1 10 = Deadband
Low = -25 = Leaaban
= Alam is generated
# Return-to-Mormal is generated

Delay Seconds The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.
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Microblock reference

Trends

Alarm text

Alarm requires
acknowledge

Return to Normal

Return Enabled

Return text

Return requires
acknowledge

Fault

Fault Enabled

Enable Trend Log
Sample every __

(hh:mm:ss)

Sample on COV
(change of value)

Max samples

Enable Trend Historian

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > View tab.

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > View tab.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

Records the microblock’s present value only when the value changes by at least the
COV Increment.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

NOTE Click Reset on the Properties page in a system to delete all samples currently
stored in the controller.

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.
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Keep historical trends for
—days

Write to historian:
Every ___ trend samples

Use default (45% of Max
samples)

In a system only:

Stop When Full

Enable trend log at specific
times only

Store Trends Now

Trend samples
accumulated since last
notification

Last Record Wrlitten to
Historlan

Delete

BACnet Configuration

Simulation

Microblock reference

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.

Check this field to stop trend sampling when the maximum number of samples is
reached.

Collects trend data for the specific period of time you define in the time and date
fields.

Writes all trend data in the controller to the system database without having to
enable trend historian.

Shows the number of samples stored in the controller since data was last written to
the database.

Shows the number of trend samples that were last written to the database.

Deletes all trend samples stored in the database for the microblock.

The Object Name is a unique alphanumeric string that defines the BACnet object.
Although the Object Name field can be edited, it is not recommended. The Notiflcation
Class is set to 1 to receive alarms generated by Carrier controllers.

Define the value(s) the microblock will use when you simulate the control program.

BACnet Analog Output

& The information below provides a FULL description of this microblock and all of its properties. What
information you see and what you can do with it depends on your license and the application you are in.

Microblock family
Icon and symbol

What it does

How it works

/0 Point microblocks (page 30)

Sends an analog (continuous) value from the control program to a physical analog
output on the controller.

point hame Ao

The Output Type, Actuator Type, Minimum Value, Maximum Value, and Resolution together determine how the
microblock converts its input value into the controller's output signal to the controlled equipment.

The Output Type tells the microblock what type of physical output it is connected to on the controller. The Actuator
Type tells the controller how to convert the signal from the controlled equipment into engineering units. The
Minimum Value and Maximum Value define the scale the microblock uses to convert the input signal from linear

Field Assistant v6.5
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Microblock reference

Actuator Types into the controller's output signal.
The microblock truncates the input value using the Resolution before performing any scaling calculations.

EXAMPLE If the wire input value is 50.073 and you set the Resolution to 0.1, the microblock uses 50.0 for any
scaling calculations.

Linear sensor types use the slope-intercept formula for a line (y=mx+b).

EXAMPLE For a microblock that uses a 0-100% open signal from a PID microblock to control a 2-10 Vdc
actuator, set the Minimum Value to O and the Maximum Value to 100. Then a 50% signal from the PID to the
microblock produces a 6 Vdc output signal.

y = PID output (%)

Maximum
value: 100—— —— ——— —— — — — —
|
|
|
|
|
|
50 100% - 0% %
m=——————— =125
10 Vdc - 2 Vdc Vdc
|
|
. ' Control
Minimum I module
value: 0
| | output
6 10 X = Vdc
-25 —& b (y-intercept)
calculated by control module
y=mx-+b
1
x="1 (y-b)
1
X = ——— (50% + 25%) = 6 Vdc
1252
7 vdc
Limitations
Outputs are limited to a controller's supported output types. See the controller's documentation for more
information.
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Configuration example

Microblock reference

For a 0-100% signal to a 2-10 Vdc damper actuator connected to analog output 2 on a controller's expander 3:

LInits

i Lo

Hardware Configuration

Expander
Cutput Mumber

Cutput Type

3
2

Electrical Qutput »

Output Configuration and Calibration

hAinimum W alue
hdaximum Walue
Resolutian

Actuator Type

Properties

Q TIPS
L]

0.0
100
0.1

Linearw! offset, 2-10%olts |+

Alt+click any value in the interface to view property details, including its editing privilege and expression
(location path) for use on graphics.

e You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only
to determine that property's functionality in your system.

Display Name

Reference Name
RefName

Description

Lock Present Value

Editing Privilege

Field Assistant v6.5
Help

The microblock label used in the Snap application and the Field Assistant interface.
You can use any characters except the " character.

Use the default reference name unless you want a more descriptive name for
graphics or network links.

Limitations:

e lower case only

e limited to 40 characters

e cannot begin with a number

e must be unique within a control program

(optional) A BACnet-visible microblock description.

Check to output the locked value from the microblock instead of the microblock's
calculated value.

Preset - Each microblock property has an appropriate privilege or role assigned to it.
You can use Global Modify in the Field Assistant interface to find out what the actual
privilege is.

& CAUTION If you change the Editing Privilege from Preset, the privilege you
select will be used for all properties of this microblock, which is not always desirable.

Carrier Proprietary and Confidential CARRIER CORPORATION ©2016

All rights reserved
55



Microblock reference

Units

The unit of measurement of the microblock's present value. Select from the BACnet
engineering units in this droplist. For some microblocks, you can customize the
droplist by selecting Options > Preferences > Droplist Options.

Hardware Configuration

Expander

Output Number
Output Type

The address of the expander (1 to 6) that has the physical output this microblock
sends a signal to. Type O for a physical output on a controller without an expander.

The number of the physical output that the microblock sends a signal to.

The physical output type of the output number that the microblock sends a signal to.

Output Configuration and Calibration

Minimum Value

Maximum Value

Resolution

Actuator Type

BACnet Configuration

Network Visible

Object Instance

COV Increment

Field Assistant v6.5
Help

The microblock value associated with the minimum signal the controlled equipment
expects.

EXAMPLE For a 2-10 Vdc actuator controlled by a 0-100% PID signal, type O so that
when the PID signal to the microblock is O, the controller sends a 2 Vdc signal to the
actuator.

The microblock value associated with the maximum signal the controlled equipment
expects.

EXAMPLE For a 2-10 Vdc actuator controlled by a 0-100% PID signal, type 100 so
that when the PID signal to the microblock is 100, the controller sends a 10 Vdc
signal to the actuator.

The increment by which the microblock updates it's input value for use in
calculations.

The Resolution format is used to truncate the microblock’s actual value. For example,
if you enter a value from:

e 0.1t0 0.9, the system uses and displays 1 digit to the right of the decimal
e 0.01t00.99, the system uses and displays 2 digits to the right of the decimal
e 1 or greater, the system uses and displays a whole number

The Resolution value determines the increment by which the present value is
updated. For example, if you enter:

e .2 the system uses and displays 8.4, 8.6, 8.8, ...
e .03, the system uses and displays 5.09, 5.12, 5.15, ...
e 10, the system uses and displays 30, 40, 50, ...

The signal the controlled equipment connected to the output number expects. See
the controller's documentation for more information on assigning inputs and outputs
to points.

Check to allow other BACnet equipment to read or change the microblock's present
value. Must be checked for this microblock to generate alarms.

Auto-assign - A BACnet Object ID is assigned by the system.

Use specific value - (0-3999999) Assign a number that is unique within the
controller.

An Analog Network Input (ANI) that references this microblock in its Address field
tries to subscribe to this microblock's COV (Change of Value) service. If subscription
succeeds, the ANI receives a value from this microblock only when this microblock's
present value changes by at least the COV Increment. If subscription fails, the ANI
reads this microblock's value at intervals specified in the ANI's Refresh Time field.
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Show Property Page
Text

Alarms

Potential alarm source

Critical

Category

Template

Alarm

Low Limit Enable

Low Limit

High Limit Enable

High Limit

Dead Band

Delay Seconds

Alarm text

Alarm requires
acknowledge

Field Assistant v6.5
Help

Microblock reference

Check to show this microblock's value on the equipment's Properties page.

Check to make this microblock available in the system's Alarm Sources list.

Determines the color of the system-wide alarm button when the alarm comes in if the
alarm's Template field is set to Universal.

‘ = Critical é\q = Non-critical

The category you want to use to filter this microblock's alarms on the system's Alarms
page > View tab.

Universal - Allows your system to use the Alarm text and Return text defined in the
microblock, and the Critical checkbox to determine the color of the system-wide
alarm button when the alarm comes in.

Check to send an alarm when the microblock's present value remains below the Low
Limit value for the defined Delay Seconds.

The value the microblock's present value must drop below to send an alarm.

Check to send an alarm when the microblock's present value remains above the High
Limit for the defined Delay Seconds.

The value the microblock's present value must rise above to send an alarm.

The amount inside the normal range by which an alarm condition must return before
a return-to-normal notification is generated.

EXAMPLE

High = 225%1G_D shand
215 - = Llea arn
B I 10 = Deadband

Low = -25 = Heachan

B Alamm is generated
* Return-to-Mormal is generated

The time the microblock's present value must remain in an alarm condition before
the microblock sends an alarm.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition occurs. A relative path is useful for alarm messages that you will reuse in
multiple Field Assistant locations because the path is relative to the item that
contains the path.

Check to require that an operator acknowledge alarm notifications on the system's
Alarms page > Vlew tab.
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Microblock reference

Return to Normal

Return Enabled

Return text

Return requires
acknowledge
Fault

Fault Enabled

Trends

Enable Trend Log

Sample every ___
(hh:mm:ss)

Sample on COV
(change of value)

Max samples

Enable Trend Historian

Keep historical trends for
—days

Write to historian:

Every ___ trend samples

Use default (45% of Max
samples)

Field Assistant v6.5
Help

Check to send a message when an alarm condition has returned to normal.

The message displayed on the Field Assistant Alarms page > View tab when an alarm
condition returns to normal. A relative path is useful for alarm messages that you will
reuse in multiple Field Assistant locations because the path is relative to the item
that contains the path.

Check to require that an operator acknowledge return-to-normal notifications on the
system's Alarms page > Vlew tab.

Check to send a message when a fault condition occurs, such as a misconfigured or
non-existent sensor.

Check to have the controller collect trend data for the microblock's present value.

Records the microblock's present value at this interval.

EXAMPLE Type 00:10:00 to record the microblock's present value every 10
minutes.

Records the microblock’s present value only when the value changes by at least the
COV Increment.

The number of data samples the controller allocates memory for. Memory
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100
samples:

(100 x 10 bytes) + 48 = 1048 bytes of memory

The allocated memory is constant regardless of how many samples are actually
recorded.

If you do not enable trending, no memory is consumed.

NOTE Click Reset on the Properties page in a system to delete all samples currently
stored in the controller.

Check this field to archive the controller's collected trend data to the system
database after every 129 data samples.

NOTES
e You must check Enable Trend Log if you want to Enable Trend Historian.

e You can change Enable Trend Historian archival settings and other trend
properties on the Properties page in a system.

This is based on the date that the sample was read. Set this field to O to use the
system default value.

Writes all trend data in the controller to the system database each time the controller
collects the specified number of samples. You can select Every __ trend samples and
enter a number greater than zero and less than the number in the Max samples field,
or you can select Use default. The number of trends specified must be accumulated
at least once before the historical trends can be viewed.
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